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Network Printing Guide

For safety, please read this manual carefully before you use this product and keep it
handy for future reference.



Introduction
To get maximum versatility from this machine all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information in the Operating Instructions before using this machine. It contains
important information related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Software Version Conventions Used in this Manual

¢ NetWare 3.x means NetWare 3.12 and 3.2.
e NetWare 4.x means NetWare 4.1, 4.11 and IntranetWare.

Trademarks

Apple, AppleTalk, EtherTalk, LaserWriter, Macintosh and Mac are registered trademarks of Apple
Computer, Inc.

Ethernet is a registered trademark of Xerox Corporation.

Microsoft, Windows and Windows NT are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

Netscape and Netscape Navigator are registered trademarks of Netscape Communications Corpora-
tion.

Novell, NetWare and NDS are registered trademarks of Novell, Inc.
PostScript is a registered trademark of Adobe Systems, Incorporated.
Sun is a registered trademark of Sun Microsystems, Inc.

SunOS is a trademark of Sun Microsystems, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

Note

The proper names of the Windows operating systems are as follows:

* The product name of Windows® 95 is Microsoft® Windows 95.

* The product name of Windows® 98 is Microsoft® Windows 98.

e The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

e The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

* The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

* The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

e Microsoft® Windows NT® Workstation 4.0



Manuails for This Machine

The following manuals describe the operational procedures and maintenance of
this machine.

To enhance safe and efficient operation of this machine, all users should read
and follow the instructions carefully.
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Printer Reference 1

Describes the system settings, procedures and functions for using this ma-
chine. This manual is also included as a PDF file on the CD-ROM labeled
“Printer Drivers and Utilities”.

Printer Reference 2

Describes the procedures and provides necessary information about using
this machine. This manual is included as a PDF file on the CD-ROM labeled
“Printer Drivers and Utilities”.

Network Printing Guide
Describes the procedures and provides necessary information about setting
up and using the machine under the network environment. We recommend

this manual as your first choice to read, and it is included as a PDF file on the
CD-ROM labeled “Printer Drivers and Utilities” (this manual).



How to Read This Manual

Symbols

In this manual, the following symbols are used:

/\ WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

N\ CAUTION:

This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.

* The statements above are notes for your safety.

ﬂlmportant
If this instruction is not followed, paper might be misfed, originals might be

damaged, or data might be lost. Be sure to read this.

5] Preparation

This symbol indicates the prior knowledge or preparations required before op-
erating.

@ Note

This symbol indicates precautions for operation, or actions to take after misop-
eration.

? Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

A Reference
This symbol indicates a reference.

[ ]

Keys that appear on the machine's display panel.

Keys and buttons that appear on the computer's display.
[ ]

Keys built into the machine's control panel.
Keys on the computer's keyboard.



Infroduction

This manual contains detailed instructions on configuring the machine as a net-
work printer. Read the section appropriate to your network environment on
how to configure the machine correctly.

Windows 2000, Windows XP,
Windows NT (Server)

Windows XP /\
N -
Windows NT @I
N~

NetWare .@I
(Client) y
Macintosh

i@klmportant

O The procedures written in this manual assume that you are a network admin-
istrator. If you are not, be sure to consult your network administrator before
configuration.

+ Features
e Support for 100BASE-TX and 10BASE-T

¢ The Network Interface Board is compatible with Windows 95/98/Me
(TCP/IP, NetBEUIL, IPP 1), Windows 2000 (TCP/IP, NetBEUI, IPP "), Win-
dows XP (TCP/IP, IPP "), Windows NT 4.0 (TCP/IP, NetBEUI, IPP ™),
NetWare (IPX/SPX, TCP/IP) and Macintosh (AppleTalk) protocols. This
allows you to use the machine in a network that uses different protocols
and operating systems.

* A computer used as a dedicated print server is not required because the
Network Interface Board can be configured as a NetWare print server.

* The Network Interface Board can connect the machine to the network
without requiring its own power supply because the Network Interface
Board is installed inside the machine.

IPP (Internet Printing Protocol) is a protocol for printing via the Internet.



Setting Up the Machine on a Network

Windows 95/98/Me

For setting up the machine as a network printer in a Windows 95/98/Me envi-
ronment, see p.1 “Windows 95/98/Me Configuration”. There are two methods
for using the machine as a network printer.

“Printing without a Print Server “Printing with a Windows 2000, Windows XP
or Windows NT Print Server

Windows 2000, Windows XP
or Windows NT Server

(or Workstation)

Print Server

TCP/P
NetBEUI
PP

Ny Ny
N N
Windows 95/98/Me Windows 95/98/Me

W95P2PSVE



Windows 2000

For setting up the machine as a network printer in a Windows 2000 environ-
ment, see p.13 “Windows 2000 Configuration”. There are two methods for using
the machine as a network printer.

«Printing without a Print Server «Printing with a Windows 2000, Windows XP
or Windows NT Print Server
Windows 2000, Windows XP
or Windows NT Server

(or Workstation)
Print Server

§or

S

—

TCP/IP
NetBEUI
IPP

LPR

5 5

Windows 2000 Windows 2000

&

W2kP2PSVE
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Windows XP

For setting up the machine as a network printer in a Windows XP environment,
see p.27 “Windows XP Configuration”. There are two methods for using the ma-
chine as a network printer.

«Printing without a Print Server «Printing with a Windows 2000, Windows XP
or Windows NT Print Server
Windows 2000, Windows XP

or Windows NT Server
(or Workstation)

Print Server
Er ¥l
S
TCP/IP
IPP
LPR

Ny Ny
N N~
Windows XP Windows XP

W2kP2PSVE



Windows NT 4.0

For setting up the machine as a network printer in a Windows NT 4.0 environ-
ment, see p.41 “Windows NT 4.0 Configuration”. There are two methods for us-
ing the machine as a network printer.

“+Printing without a Print Server “Printing with a Windows 2000, Windows XP
or Windows NT Print Server

Windows 2000, Windows XP
or Windows NT Server

(or Workstation)

Print Server

TCP/IP

NetBEUI

PP

B S L]

Windows NT 4.0 Windows NT 4.0

NT40P2PSVE
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NetWare

For setting up the machine as a network printer in a NetWare environment, see
p-55 “NetWare Configuration”. The Network Interface Board allows you to use
the machine as either a print server or a remote printer.

For more information about setting up the clients, see the following pages.
e Windows 95/98/Me = p.74 “Windows 95/98 /Me”

¢ Windows 2000, Windows XP= p.75 “Windows 2000/ Windows XP”

* Windows NT 4.0 = p.76 “Windows NT 4.0”

Configuring the machine as a print server

A dedicated NetWare print server is not required because the machine can be
configured as a print server.

Print Server NetWare
g File Server

N &

Windows 95/98/Me Windows 2000/Windows XP Windows NT 4.0

GSTN0O2e

The actual procedures for configuring the machine depend on the NetWare ver-
sion.

¢ NetWare 3.x = p.61 “Setting Up as a Print Server”
* NetWare 4.x,5/5.1 = p.67 “Setting Up as a Print Server”



Configuring the machine as a remote printer

If a dedicated NetWare print server is being used, the machine should be config-
ured as a remote printer.

Remote Printer NetWare NetWare
Print Server File Server
I
S S

Windows 95/98/Me  Windows 2000/Windows XP Windows NT 4.0

GSTNO003e

The actual procedures for configuring the machine depend on the NetWare ver-
sion.

¢ NetWare 3.x = p.63 “Setting Up as a Remote Printer”
* NetWare 4.x,5/5.1 = p.71 “Setting Up as a Remote Printer”

Macintosh

For setting up the machine as a network printer in a Macintosh environment, see
p-77 “Macintosh Configuration”.

AppleTalk

S

Macintosh

MacP2Pe
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D
1. Windows 95/98/Me

Configuration

Configuring Windows 95/98/Me

Printing without a Print Server

The following procedure describes how to configure Windows 95/98 /Me to use
the machine on a network without a Windows 2000 Server, Windows 2000 Pro-
fessional, Windows XP, Windows NT Server, Windows NT Workstation or Net-
Ware based print server.

D indicates topics explained in this document

[1. Specify the protocol to use J
Consult your network administrator about which of the three protocols is appropriate.
TCP/IP IPP NetBEUI
[ 2. Configure the chosen protocol J
" — e "Configuring NetBEUI
D Configuring TCP/IP and IPP for Printing for Printing"

[ 3. Select the appropriate software

If using the printer... If managing printers...

SmartNetMonitor SmartNetMonitor
for Client for Admin

4. Install the software and set
the printer driver port

W N

"Using SmartNetMonitor D "Using SmartNetMonitor
for Client" for Admin"

4. Install the software J

setupguide

Printing with a Windows 2000/Windows XP or Windows NT Print
Server

See p.10 “Setting Up a Client Computer” for configuring Windows 95/98/Me
with a Windows 2000/ Windows XP or Windows NT print server.



Windows 95/98/Me Configuration

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 95/98/Me to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

/O Reference

For more information about how to make the above settings, Printer Refer-
ence 1.

If DHCP is used to assign IP addresses, see p.119 “When Using DHCP”.

@ Note

O After setting the IP address, use the ping command to make sure that it has
been set correctly.

@ Enable the use of the command prompt as follows:

e On Windows 95 or Windows 98
Click [Start], point to [Programs], and then click [MS-DOS Prompt].

¢ On Windows Me
Click [Start], point to [Programs], point to [Accessories], and then click
[Command Prompt].

@ Type the following: (192.168.15.16 is an example IP address.)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.



Configuring the Protocols

Configuring a Windows 95/98/Me computer

These steps are for configuring a Windows 95/98/Me computer to use the
TCP/IP protocol.

ﬂ Open [Control Panel] and double-click the [Network] icon. Make sure that
“TCP/IP” is listed in the [The following network components are installed:] box on
the [Configuration] tab.

& Note
O If the TCP/IP protocol is not installed, click [Add] on the [Configuration] tab

to install it. For more information about installing the TCP /IP protocol, see
Windows 95/98/Me Help.

ﬂ Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 95/98/Me to use the NetBEUI protocol.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
* Make sure that the NetBEUI protocol is set to active. (The default is active.)

& Note

O The NetBEUI settings are performed in Web Status Monitor or SmartNet-
Monitor for Admin. See the corresponding online Help for details.

Configuring a Windows 95/98/Me computer

Install the NetBEUI protocol on the Windows 95/98/Me computer and set it as
the default protocol.

ﬂ Open [Control Panel] and double-click the [Network] icon. Make sure that
“NetBEUI” is listed in the [The following network components are installed:] box
on the [Configuration] tab.

& Note

O If the NetBEUI protocol is not installed, click [Add] on the [Configuration] tab
to install it. For more information about installing the NetBEUI protocol,
see Windows 95/98/Me Help.

O If “NetBEUI —Dial-Up Adaptor” is listed in the [The following network com-
ponents are installed:] box, select it and click [Remove] to remove the binding.




Windows 95/98/Me Configuration

ﬂ Set the NetBEUI protocol as the default protocol. Click the [Configuration]
tab, select “NetBEUI” in the [The following network components are installed:]
box, and click [Properties].

B Click the [Advanced] tab, select [Set this protocol to be the default protocol], and
click [OK].

ﬂ Click [OK] to close the [Network] dialog box.

B Check the message to restart, and then click [Yes].



Using SmartNetMonitor for Client

Using SmartNetMonitor for Client

SmartNetMonitor for Client is a utility for printing with the network printer us-
ing the TCP/IP, NetBEU]I, and IPP protocols. The following features are availa-
ble when using SmartNetMonitor for Client.

% SmartNetMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.
* That print did completion (data transmission is finished) is informed.

& Note

O Make sure to close all applications before beginning the installation process.
Installing SmartNetMonitor for Client may require the computer to be restart-
ed.

Installing SmartNetMonitor for Client

Follow the procedure below to install SmartNetMonitor for Client.

& Note

O When there is a printing port used by PortNavi, Multi Direct Print and Print-
ing System95, SmartNetMonitor for Client will take over.

O When using SmartNetMonitor for Admin, install SmartNetMonitor for Client
after SmartNetMonitor for Admin is closed.

O Make sure to close all applications before beginning the installation process.
Installing SmartNetMonitor for Client may require the computer to be restart-
ed.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

g Open [Control Panel], and double-click the [Add/Remove Programs] icon.
B On the [Install/Uninstall] tab, click [Install].
O click [Next >].

B Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\ NETWORK \ NETMON \ CLIENT \ DISK1 \
SETUP.EXE” (do not include the quotation marks), and then click [Finish].

& Note
O An example would be “D:\ NETWORK \ NETMON \ CLIENT \ DISK1
\ SETUP.EXE” when the CD-ROM drive letter is “D”.
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B From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

ﬂ After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.
After the installation is complete, configure the printer port with SmartNet-
Monitor for Client. = p.7 “Setting Up the Printer Driver”

@ Note

O If the dialog box asking if you want to restart the computer appears, select
[Yes, | want to restart my computer now.].

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it.

ye Reference
For more information about SmartNetMonitor for Client, see SmartNetMon-
itor for Client Help.

ﬂ From the [Printers] window, click the icon of the machine which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

ﬂ Click the [Details] tab and make sure that the SmartNetMonitor for Client
port is shown in the [Print to the following port:] box.

Remember the port name because this port should be deleted later.
B From the [Print to the following port:] box, select [FILE].
A click [0k
B Click [Delete Port].

E Click the SmartNetMonitor for Client port name as in step fJ, and then click
[OK].

The port is deleted.
ﬂ Click [OK] to close the Printer Properties.



Using SmartNetMonitor for Client

Uninstalling SmartNetMonitor for Client

5] Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:

¢ The port settings dialog box is closed.
* No printer is using the SmartNetMonitor for Client port as a printer port.

ﬂ Open [Control Panel], and double-click the [Add/Remove Programs] icon.

ﬂ On the [Install/Uninstall] tab, click [SmartNetMonitor for Client], and click [Add/Re-
move].

B After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.

ﬂ After the confirmation message appears, click [Yes].
B Acknowledge the [Question] dialog box.

E When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

5] Preparation
The target machine must be turned on before starting the installation process.

ﬂ Install the printer driver of the machine you want to use.

ﬂ From the [Printers] window, click the icon of the machine. On the [File]
menu, click [Properties].

B Click the [Details] tab, and then click [Add Port].
The [Add Port] dialog box appears.

ﬂ Click [Other], click [SmartNetMonitor] from the list, and then click [OK].
The [Select Printer] dialog box appears.
The displayed items are as follows:
Model Name: The model name of the printer.
Printer Name: The name of the printer.

Comment: Additional information about the printer.
Address: The IP address of the printer.
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B Select the machine.

TCP/IP

@ Click [TCP/IP], and then click [search].
A list of printers that can be printed to by the TCP/IP protocol appears.
@ Click the machine you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

NetBEUI

@ Click [NetBEUI], and then click [search].
A list of printers that can be printed to by the NetBEUI protocol appears.
@ Click the machine you want to use, and then click [OK].

& Note

O Printers that respond to a broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the system configuration list. For information about the printing of
the system configuration list, see Printer Reference 2.

O You cannot print to printers beyond routers.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the machine, type "http://machine's-ip-ad-
dress/printer" or "ipp://machine's-ip-address/printer" in the [Printer URL]
field.

(192.168.15.16 is an example IP address)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© If necessary, type a names to distinguish printers in [IPP Port Name]. Type
a name different from any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.



Using SmartNetMonitor for Client

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

p Reference

For more information about these settings, see SmartNetMonitor for
Client Help.

A ciick [0k
ﬂ Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port:] box, and then click [OK].

This completes the settings.

To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.

Changing Port Settings

Follow these steps to change SmartNetMonitor for Client settings, such as
TCP/IP, the proxy server and IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

O You can configure Timeout Settings for the TCP/IP protocol.

ﬂ From the [Printers] window, click the icon of the machine you want to use.
On the [File] menu, click [Properties].

ﬂ Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.

* For TCP/IP protocol, you can configure Timeout Settings.
* For IPP, you can configure User Settings or Proxy Settings.

p Reference

For more information about these settings, see SmartNetMonitor for Client
Help.
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Setting Up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000/ Windows XP, Windows NT Server or Windows NT Work-
station as a print server.

When using a Windows 2000/ Window XP or Windows NT print server, select
a shared printer on Windows 2000/ Windows XP or Windows NT.

Windows 2000, Windows XP
or Windows NT Print Server

NG

N

Windows 95/98/Me

WO98NTPOO1E

@ Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

ﬂ Install the printer driver as a local printer.

p Reference

For more information about installing the printer driver, see Printer Refer-
ence 1.

& Note

O Any port can be selected during the installation, however, LPT1 is recom-
mended.

B Click [Start], point to [Settings], and then click [Printers].

B Click the icon of the machine you want to use. On the [File] menu, click
[Properties].

O Click the [Details] tab, and click [Add Port].
B ciick [Network], and click [Browse].



Setting Up a Client Computer

B On the network tree, double-click the name of the computer used as a print
server.

The printers connected to the network are displayed.
ﬂ Click the name of the machine you want to use, and click [OK].
B click [0k,

g Make sure that the port name is displayed in the [Print to the following port:]
box, and click [OK].

11
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L
2. Windows 2000

Configuration

Configuring Windows 2000

Printing without a Print Server

The following procedure describes how to configure Windows 2000 to use the
machine on a network without a Windows 2000 Server, Windows 2000 Profes-
sional, Window XP, Windows NT Server, Windows NT Workstation or Net-
Ware based print server.

D indicates topics explained in this document

[1. Specify the protocol to use J
Consult your network administrator about which of the three protocols is appropriate.
TCP/IP IPP NetBEUI
[ 2. Configure the chosen protocol J
" — e "Configuring NetBEUI
D Configuring TCP/IP and IPP for Printing D for Printing"

[ 3. Select the appropriate software ]

If using the printer... If managing printers...

SmartNetMonitor SmartNetMonitor
for Client for Admin

4. Install the software and set
the printer driver port

W N

"Using SmartNetMonitor D "Using SmartNetMonitor
for Client" for Admin"

4. Install the software J

setupguide

13
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Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows 2000 to enable Peer-to-
Peer printing in a network environment.

For more information about Standard TCP/IP port settings, see Windows 2000
Help.

& Note

O If a device model selection dialog box appears during the procedure to add
the Standard TCP/IP port, select "RICOH Network Printer C Model".

Printing with a LPR Port

See p.23 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows 2000.

Printing with a Windows 2000 or Windows NT Print Server

See p.24 “Setting Up a Client Computer” for configuring Windows 2000 with a
Windows 2000/ Windows XP or Windows NT print server.



Configuring the Protocols

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 2000 to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

/O Reference

For more information about how to make the above settings, see Printer Ref-
erence 1.

If DHCP is used to assign IP addresses, see p.119 “When Using DHCP”.

@ Note

O After setting the IP address, use the ping command to make sure that it has
been set correctly.

@ Click [Start], point to [Programs], point to [Accessories], and then click [Com-
mand Prompt].

® Type the following: (192.168.15.16 is an example IP address.)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.

Configuring a Windows 2000 computer

These steps are for configuring a Windows 2000 computer to use the TCP/IP
protocol.

B Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

g Double-click [Local Area Connection]. On the [General] tab, click [Properties].

15
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B Make sure that “Internet Protocol (TCP/IP)” is selected in the [Components
checked are used by this connection:] box on the [General] tab.

& Note
O Select the TCP/IP protocol box if it is not already selected.

O If the TCP/IP protocol is not installed, click [Install] on the [General] tab to
install it. For more information about installing the TCP/IP protocol, see
Windows 2000 Help.

ﬂ Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 2000 to use the NetBEUI protocol.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
* Make sure that the NetBEUI protocol is set to active. (The default is active.)

& Note

O The NetBEUI settings are performed in Web Status Monitor or SmartNet-
Monitor for Admin. See the corresponding online Help for details.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the NetBEUI
protocol.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

ﬂ Double-click [Local Area Connection]. On the [General] tab, click [Properties].

BMake sure that the “NetBEUI Protocol” is selected in the [Components
checked are used by this connection:] box on the [General] tab.

& Note
O Select the NetBEUI protocol box if it is not already selected.
O If the NetBEUI protocol is not installed, click [Install] on the [General] tab to

install it. For more information about installing the NetBEUI protocol, see
Windows 2000 Help.



Using SmartNetMonitor for Client

Using SmartNetMonitor for Client

SmartNetMonitor for Client is a utility for printing with the network printer us-
ing the TCP/IP, NetBEU]I, and IPP protocols. The following features are availa-
ble when using SmartNetMonitor for Client.

% SmartNetMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.
* That print did completion (data transmission is finished) is informed.

? Limitation

O On a computer that is used as a print server, do not use the features such as
Notify. For more information about turning off these features, see SmartNet-
Monitor for Client Help.

& Note

O Make sure to close all applications before beginning the installation process.
Installing SmartNetMonitor for Client may require the computer to be restart-
ed.

Installing SmartNetMonitor for Client

Follow the procedure below to install SmartNetMonitor for Client.

& Note

O When there is a printing port used by PortNavi, Multi Direct Print and Print-
ing System95, SmartNetMonitor for Client will take over.

O When using SmartNetMonitor for Admin, install SmartNetMonitor for Client
after SmartNetMonitor for Admin is closed.

O Make sure to close all applications before beginning the installation process.
Installing SmartNetMonitor for Client may require the computer to be restart-
ed.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

ﬂ Open [Control Panel], and double-click the [Add/Remove Programs] icon.
B On the [Add New Programs] tab, click [CD or Floppy].
O click [Next >].

17
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B Type the name of the CD-ROM drive in the [Open] box, followed by “:\
NETWORK \ NETMON \ CLIENT \ DISK1 \ SETUP.EXE” (do not in-
clude the quotation marks), and then click [Finish].

& Note

O An example would be “D:\ NETWORK \ NETMON \ CLIENT \ DISK1
\ SETUP.EXE” when the CD-ROM drive letter is “D”.

B From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

ﬂ After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.
After the installation is complete, configure the printer port with SmartNet-
Monitor for Client. = p.20 “Setting Up the Printer Driver”

@ Note

O If the dialog box asking if you want to restart the computer appears, select
[Yes, | want to restart my computer now.].

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it.

p Reference

For more information about SmartNetMonitor for Client, see SmartNetMon-
itor for Client Help.

ﬂ From the [Printers] window, click the icon of the machine which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

ﬂ Click the [Ports] tab and make sure that the SmartNetMonitor for Client
port is shown in the [Print to the following port(s)] box.

Remember the port name because this port should be deleted later.
B Select the [FILE] check box in the [Port] column.

ﬂ Click [OK] to close the Printer Properties.
The port which is currently in use is changed.

B Open the Printer Properties of the same machine.
[ seciect the [Ports] tab.

ﬂ At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the SmartNetMonitor for Client port name as in step |J.
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B cick [pelete Port].

g After the confirmation message appears, click [Yes].
The port is deleted.

[E Click [Close] to close the Printer Properties.

Uninstalling SmartNetMonitor for Client

5] Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:

* The port settings dialog box is closed.
* No printer is using the SmartNetMonitor for Client port as a printer port.

* You have performed login with the same user authority as that used to in-
stall SmartNetMonitor for Client.

l] Open [Control Panel], and double-click the [Add/Remove Programs] icon.

g Click the [Change or Remove Programs] tab, click [SmartNetMonitor for Client],
and click [Change/Remove].

B After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.

ﬂ After the confirmation message appears, click [Yes].
B Acknowledge the [Remove Shared File?] dialog box.

B When the uninstallation is complete, click [OK].

19
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Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

5] Preparation
The target machine must be turned on before starting the installation process.

ﬂ Install the printer driver of the machine you want to use.

g From the [Printers] window, click the icon of the machine. On the [File]
menu, click [Properties].
B Click the [Ports] tab, and then click [Add Port].
The [Add Port] dialog box appears.
ﬂ Click [SmartNetMonitor] in the [Available port types:] box, and then click [New
Port].
The [Select Printer] dialog box appears.
The displayed items are as follows:
Model Name: The model name of the printer.
Printer Name: The name of the printer.
Comment: Additional information about the printer.
Address: The IP address of the printer.

B Select the machine.

TCP/IP

@ Click [TCP/IP], and then click [search].
A list of printers that can be printed to by the TCP/IP protocol appears.
@ Click the machine you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] , and
then type the IP address or host name.
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NetBEUI

@ Click [NetBEUI], and then [search].
A list of printers that can be printed by the NetBEUI protocol appears.

@ Click the printer you want to use, and then click [OK].

& Note
O Printers that respond to a broadcast from the computer will be dis- g
played. To print to a printer not listed here, click [Specify Address], and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the system configuration list. For information about the printing of
the system configuration list, see Printer Reference 2.

O You cannot print to printers beyond routers.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the machine, type "http://machine's-ip-ad-
dress/printer" or "ipp://machine's-ip-address/printer" in the [Printer URL]
field.

(192.168.15.16 is an example IP address.)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© If necessary, type a name to distinguish printers in [IPP Port Name]. Type
a name different from any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

/O Reference

For more information about these settings, see SmartNetMonitor for
Client Help.

@ Click [OK].

A ciick [ox.

t ciick [Close].

8 Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [OK].

This completes the settings.

To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.

2]



22

Windows 2000 Configuration

Changing Port Settings

Follow these steps to change SmartNetMonitor for Client settings, such as
TCP/IP, the proxy server and IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

ﬂ From the [Printers] window, click the icon of the machine you want to use.
On the [File] menu, click [Properties].
ﬂ Click the [Ports] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.
* For TCP/IP protocol, you can configure Timeout Settings.
* For IPP, you can configure User Settings or Proxy Settings.
A Reference

For more information about these settings, see SmartNetMonitor for Client
Help.



Configuring LPR Port Printing

Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
2000.

@ Note

O The following procedure assumes that the printer drivers have already been
installed. This is the procedure to change the printer port to LPR.

O The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocols, see p.15 “Configuring TCP/IP
and IPP for Printing”.

B ciicx [Start], point to [Settings], and then click [Printers].

g Click the icon of the machine you want to use. On the [File] menu, click
[Properties].

B Click the [Ports] tab, and then click [Add Port].
ﬂ In the [Available port types:] box, click “LPR Port”, and then click [New Port].

& Note

O If “LPR Port” does not appear, “Print Services for Unix” has not been in-
stalled.

B Type the IP address of the Network Interface Board into the [Name or address
of server providing Ipd:] box.

B Type “1p” into the [Name of printer or print queue on that server:] box, and click
[OK].

t click [Close].

B Make sure that the port name is displayed in the [Print to the following port(s)]
box and the check box is selected, and then click [OK].
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Setting Up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000/ Windows XP, Windows NT Server or Windows NT Work-
station as a print server.

When using a Windows 2000/ Windows XP, Windows NT print server, select a
shared printer on Windows 2000/ Windows XP or Windows NT.

Windows 2000, Windows XP
or Windows NT Print Server

i

Windows 2000

W2kNTPOO1E

& Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

Use the [Printers] window to set up the machine.
B clicx [Start], point to [Settings], and then click [Printers].

g Double-click the [Add Printer] icon.
This launches the Add Printer Wizard.

B Click [Next >].
ﬂ Click [Network printer], and click [Next >].
B Click [Next >].

E In the [Shared printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.



Setting Up a Client Computer

ﬂ Click the machine you want to use, and click [Next >].

& Note

O If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and follow the in-
structions on the screen.

O There is a Windows 2000 printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

B Select whether to use this machine as the default printer, and click [Next >].

E) After the installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.

25
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e
3. Windows XP Configuration

Configuring Windows XP

Printing without a Print Server

The following procedure describes how to configure Windows XP to use the ma-
chine on a network without a Windows 2000 Server, Windows 2000 Profession-
al, Window XP, Windows NT Server, Windows NT Workstation or NetWare
based print server.

D indicates topics explained in this document

[1. Specify the protocol to use J
Consult your network administrator about which of the three protocols is appropriate.
TCP/IP IPP
[ 2. Configure the chosen protocol J

" Configuring TCP/IP and IPP for Printing"

[ 3. Select the appropriate software ]

If using the printer... If managing printers...

SmartNetMonitor SmartNetMonitor
for Client for Admin

4. Install the software and set
the printer driver port

W N

"Using SmartNetMonitor D "Using SmartNetMonitor
for Client" for Admin"

4. Install the software J

setupguide

27
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Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows XP to enable Peer-to-Peer
printing in a network environment.

For more information about Standard TCP/IP port settings, see Windows 2000
Help.

& Note
O If a device model selection dialog box appears during the procedure to add
the Standard TCP/IP port, select "RICOH Network Printer C Model".

Printing with a LPR Port

See p.37 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows XP.

Printing with a Windows 2000/Windows XP or Windows NT Print
Server

See p.38 “Setting Up a Client Computer” for configuring Windows XP with a
Windows 2000/ Windows XP or Windows NT print server.



Configuring the Protocols

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows XP to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

/O Reference

For more information about how to make the above settings, see Printer Ref-
erence 1.

If DHCP is used to assign IP addresses, see p.119 “When Using DHCP”.

@ Note

O After setting the IP address, use the ping command to make sure that it has
been set correctly.

@ Click [Start], point to [Programs], point to [Accessories], and then click [Com-
mand Prompt].

® Type the following: (192.168.15.16 is an example IP address.)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.

Configuring a Windows XP computer

These steps are for configuring a Windows XP computer to use the TCP/IP pro-
tocol.

B Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

g Double-click [Local Area Connection]. On the [General] tab, click [Properties].

29
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B Make sure that “Internet Protocol (TCP/IP)” is selected in the [Components
checked are used by this connection:] box on the [General] tab.

& Note
O Select the TCP/IP protocol box if it is not already selected.

O If the TCP/IP protocol is not installed, click [Install] on the [General] tab to
install it. For more information about installing the TCP/IP protocol, see
Windows XP Help.

ﬂ Configure the TCP/IP protocol with the appropriate IP address, subnet

B mask and other settings.
Check with the network administrator that the settings are correct.

30
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Using SmartNetMonitor for Client

SmartNetMonitor for Client is a utility for printing with the network printer us-
ing the TCP/IP, and IPP protocols. The following features are available when
using SmartNetMonitor for Client.

% SmartNetMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.
* That print did completion (data transmission is finished) is informed.

? Limitation

O On a computer that is used as a print server, do not use the features such as
Notify. For more information about turning off these features, see SmartNet-
Monitor for Client Help.

& Note
O Make sure to close all applications before beginning the installation process.

Installing SmartNetMonitor for Client may require the computer to be restart-
ed.

Installing SmartNetMonitor for Client

Follow the procedure below to install SmartNetMonitor for Client.

& Note

O When there is a printing port used by PortNavi, Multi Direct Print and Print-
ing System95, SmartNetMonitor for Client will take over.

O When using SmartNetMonitor for Admin, install SmartNetMonitor for Client
after SmartNetMonitor for Admin is closed.

O Make sure to close all applications before beginning the installation process.
Installing SmartNetMonitor for Client may require the computer to be restart-
ed.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

ﬂ Open [Control Panel], and double-click the [Add/Remove Programs] icon.
B On the [Add New Programs] tab, click [CD or Floppy].
O click [Next >].
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B Type the name of the CD-ROM drive in the [Open] box, followed by “:\
NETWORK \ NETMON \ CLIENT \ DISK1 \ SETUP.EXE” (do not in-
clude the quotation marks), and then click [Finish].

& Note

O An example would be “D:\ NETWORK \ NETMON \ CLIENT \ DISK1
\ SETUP.EXE” when the CD-ROM drive letter is “D”.

B From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

ﬂ After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.
After the installation is complete, configure the printer port with SmartNet-
Monitor for Client. = p.34 “Setting Up the Printer Driver”

@ Note

O If the dialog box asking if you want to restart the computer appears, select
[Yes, | want to restart my computer now.].

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it.

p Reference

For more information about SmartNetMonitor for Client, see SmartNetMon-
itor for Client Help.

ﬂ From the [Printers] window, click the icon of the machine which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

ﬂ Click the [Ports] tab and make sure that the SmartNetMonitor for Client
port is shown in the [Print to the following port(s)] box.

Remember the port name because this port should be deleted later.
B Select the [FILE] check box in the [Port] column.

ﬂ Click [OK] to close the Printer Properties.
The port which is currently in use is changed.

B Open the Printer Properties of the same machine.
[ seciect the [Ports] tab.

ﬂ At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the SmartNetMonitor for Client port name as in step |J.
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B cick [pelete Port].

g After the confirmation message appears, click [Yes].
The port is deleted.

[E Click [Close] to close the Printer Properties.

Uninstalling SmartNetMonitor for Client

5] Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:

* The port settings dialog box is closed.
* No printer is using the SmartNetMonitor for Client port as a printer port.

* You have performed login with the same user authority as that used to in-
stall SmartNetMonitor for Client.

l] Open [Control Panel], and double-click the [Add/Remove Programs] icon.

g Click the [Change or Remove Programs] tab, click [SmartNetMonitor for Client],
and click [Change/Remove].

B After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.

ﬂ After the confirmation message appears, click [Yes].
B Acknowledge the [Remove Shared File?] dialog box.

B When the uninstallation is complete, click [OK].
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Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

5] Preparation
The target machine must be turned on before starting the installation process.

ﬂ Install the printer driver of the machine you want to use.

g From the [Printers] window, click the icon of the machine. On the [File]
menu, click [Properties].
B Click the [Ports] tab, and then click [Add Port].
The [Add Port] dialog box appears.
ﬂ Click [SmartNetMonitor] in the [Available port types:] box, and then click [New
Port].
The [Select Printer] dialog box appears.
The displayed items are as follows:
Model Name: The model name of the printer.
Printer Name: The name of the printer.
Comment: Additional information about the printer.
Address: The IP address of the printer.

B Select the machine.

TCP/IP

@ Click [TCP/IP], and then click [search].
A list of printers that can be printed to by the TCP/IP protocol appears.
@ Click the machine you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] , and
then type the IP address or host name.
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IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the machine, type "http://machine's-ip-ad-
dress/printer" or "ipp://machine's-ip-address/printer" in the [Printer URL]
field.

(192.168.15.16 is an example IP address.)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© If necessary, type a name to distinguish the printers in [IPP Port Name].
Type a name different from any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

A Reference
For more information about these settings, see SmartNetMonitor for
Client Help.

@ Click [OK].
A ciick [ox.
W click [Close].

B Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [OK].

This completes the settings.

To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.
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Changing Port Settings

Follow these steps to change SmartNetMonitor for Client settings, such as
TCP/IP, the proxy server and IPP URL.

ﬂ From the [Printers] window, click the icon of the machine you want to use.
On the [File] menu, click [Properties].
) Click the [Ports] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.
¢ For TCP/IP protocol, you can configure Timeout Settings.
¢ For IPP, you can configure User Settings or Proxy Settings.

/O Reference

For more information about these settings, see SmartNetMonitor for Client
Help.



Configuring LPR Port Printing

Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
XP.

@ Note

O The following procedure assumes that the printer drivers have already been
installed. This is the procedure to change the printer port to LPR.

O The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocols, see p.29 “Configuring TCP/IP
and IPP for Printing”.

B ciicx [Start], point to [Settings], and then click [Printers].

g Click the icon of the machine you want to use. On the [File] menu, click
[Properties].

B Click the [Ports] tab, and then click [Add Port].
ﬂ In the [Available port types:] box, click “LPR Port”, and then click [New Port].

& Note

O If “LPR Port” does not appear, “Print Services for Unix” has not been in-
stalled.

B Type the IP address of the Network Interface Board into the [Name or address
of server providing Ipd:] box.

B Type “1p” into the [Name of printer or print queue on that server:] box, and click
[OK].

t click [Close].

B Make sure that the port name is displayed in the [Print to the following port(s)]
box and the check box is selected, and then click [OK].
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Setting Up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000/ Windows XP, Windows NT Server or Windows NT Work-
station as a print server.

When using a Windows 2000/ Windows XP, Windows NT print server, select a
shared printer on Windows 2000/ Windows XP or Windows NT.

Windows 2000, Windows XP
or Windows NT Print Server

@
Windows XP

W2kNTPOO1E

& Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000/ Windows XP or Windows NT print server. Do not
begin the following procedure until the client has been set up and configured
correctly.

Use the [Printers] window to set up the machine.
B cicx [Start], point to [Settings], and then click [Printers].

g Double-click the [Add Printer] icon.
This launches the Add Printer Wizard.

B Click [Next >].
ﬂ Click [Network printer], and click [Next >].
B click (Next >].

E In the [Shared printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.



Setting Up a Client Computer

ﬂ Click the machine you want to use, and click [Next >].

& Note

O If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and follow the in-
structions on the screen.

O There is a Windows XP printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

B Select whether to use this machine as the default printer, and click [Next >].

E) After the installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.
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.
4. Windows NT 4.0

Configuration

Configuring Windows NT 4.0

Printing without a Print Server

The following procedure describes how to configure Windows NT 4.0 to use the
machine on a network without a Windows 2000 Server, Windows 2000 Profes-
sional, Windows XP, Windows NT Server, Windows NT Workstation or Net-
Ware based print server.

D indicates topics explained in this document

[1. Specify the protocol to use J
Consult your network administrator about which of the three protocols is appropriate.
TCP/IP IPP NetBEUI
[ 2. Configure the chosen protocol J
" — e "Configuring NetBEUI
D Configuring TCP/IP and IPP for Printing D for Printing"

[ 3. Select the appropriate software ]

If using the printer... If managing printers...

SmartNetMonitor SmartNetMonitor
for Client for Admin

4. Install the software and set
the printer driver port

W N

"Using SmartNetMonitor D "Using SmartNetMonitor
for Client" for Admin"

4. Install the software J

setupguide
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Printing with a LPR Port

See p.52 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows NT 4.0.

Printing with a Windows 2000/Windows XP or Windows NT Print
Server

See p.53 “Setting Up a Client Computer” for configuring Windows NT 4.0 with
a Windows 2000/ Windows XP or Windows NT print server.



Configuring the Protocols

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows NT to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

/O Reference

For more information about how to make the above settings, see Printer Ref-
erence 1.

If DHCP is used to assign IP addresses, see p.119 “When Using DHCP”.

@ Note

O After setting the IP address, use the ping command to make sure that it has
been set correctly.

@ Click [Start], point to [Programs], and then click [Command Prompt].

@ Type the following: (192.168.15.16 is an example IP address.)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.
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Configuring a Windows NT computer

These steps are for configuring a Windows NT computer to use the TCP/IP pro-
tocol.

ﬂ Open [Control Panel] and double-click the [Network] icon. Make sure that
“TCP/IP Protocol” is listed in the [Network Protocols:] box on the [Protocols]
tab.

& Note
O If the TCP/IP protocol is not installed, click [Add] on the [Protocols] tab to

install it. For more information about installing the TCP/IP protocol, see
Windows NT Help.

ﬂ Configure the TCP/IP protocols with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

B Click the [Services] tab, and make sure that “Microsoft TCP/IP Printing” is
installed.

If “Microsoft TCP/IP Printing” is not installed, click [Add] on the [Services] tab
to install it. For more information about installing and configuring network
services, see Windows NT Help.
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Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows NT to use the NetBEUI protocol.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
* Make sure that the NetBEUI protocol is set to active. (The default is active.)

& Note

O The NetBEUI settings are performed in Web Status Monitor or SmartNet-
Monitor for Admin. See the corresponding online Help for details.

Configuring a Windows NT computer

Install the NetBEUI protocol on the Windows NT computer, and change the
LAN adapter number (Lana Number).

ﬂ Open [Control Panel] and double-click the [Network] icon. Make sure that
“NetBEUI Protocol” is listed in the [Network Protocols:] box on the [Protocols]
tab.

& Note
O If the NetBEUI protocol is not installed, click [Add] on the [Protocols] tab to

install it. For more information about installing the NetBEUI protocol, see
Windows NT Help.

g Change the Lana Number. Click the [Services] tab, click “NetBIOS Inter-
face” in the [Services] tab, and click [Properties].

B Click the Lana Number corresponding the Nbf protocol of the [Network
Route] headline, and click [Edit].

ﬂ Type “0” as the Lana Number.

& Note
O If the other protocol's Lana Number is configured with “0”, you must
change the Lana Number to a number other than “0”.

B ciick [0k
B Click [Close] to close the [Network] dialog box.
ﬂ Check the message to restart, and then click [Yes].

& Note
O After you change the Lana Number, you must restart the computer.
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Using SmartNetMonitor for Client

SmartNetMonitor for Client is a utility for printing with the network printer us-
ing the TCP/IP, NetBEUI, and IPP protocols. The following features are availa-
ble when using SmartNetMonitor for Client.

% SmartNetMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.
* That print did completion (data transmission is finished) is informed.

? Limitation

O On a computer that is used as a print server, do not use the features such as
Notify. For more information about turning off these features, see SmartNet-
Monitor for Client Help.

& Note

O Make sure to close all applications before beginning the installation process.
Installing SmartNetMonitor for Client may require the computer to be restart-
ed.

Installing SmartNetMonitor for Client

Follow the procedure below to install SmartNetMonitor for Client.

& Note
O When there is a printing port used by PortNavi, Multi Direct Print and Print-
ing System95, SmartNetMonitor for Client will take over.

O When using SmartNetMonitor for Admin, install SmartNetMonitor for Client
after SmartNetMonitor for Admin is closed.

O Make sure to close all applications before beginning the installation process.
Installing SmartNetMonitor for Client may require the computer to be restart-
ed.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

ﬂ Open [Control Panel], and double-click the [Add/Remove Programs] icon.
B On the [Install/Uninstall] tab, click [Install].
O click [Next >].



Using SmartNetMonitor for Client

B Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\ NETWORK \ NETMON \ CLIENT \ DISK1 \
SETUP.EXE” (do not include the quotation marks), and then click [Finish].

& Note

O An example would be “D:\ NETWORK \ NETMON \ CLIENT \ DISK1
\ SETUP.EXE” when the CD-ROM drive letter is “D”.

B From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

ﬂ After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.
After the installation is complete, configure the printer port with SmartNet-
Monitor for Client. = p.49 “Setting Up the Printer Driver”

@ Note

O If the dialog box asking if you want to restart the computer appears, select
[Yes, | want to restart my computer now.].

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it.

p Reference

For more information about SmartNetMonitor for Client, see SmartNetMon-
itor for Client Help.

ﬂ From the [Printers] window, click the icon of the machine which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

ﬂ Click the [Ports] tab and make sure that the SmartNetMonitor for Client
port is shown in the [Print to the following port(s)] box.

Remember the port name because this port should be deleted later.
B From the [Print to the following port(s)] box, select [FILE].

A click [0K].
The port which is currently in use is changed.

B Click [Delete Port].

B After the confirmation message appears, click [Yes].
The port is deleted.

ﬂ Click [OK] to close the Printer Properties.
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Uninstalling SmartNetMonitor for Client

5] Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:

* The port settings dialog box is closed.
* No printer is using the SmartNetMonitor for Client port as a printer port.

* You have performed login with the same user authority as that used to in-
stall SmartNetMonitor for Client.

ﬂ Open [Control Panel], and double-click the [Add/Remove Programs] icon.

ﬂ On the [Install/Uninstall] tab, click [SmartNetMonitor for Client], and click [Add/Re-
move].

B After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.

ﬂ After the confirmation message appears, click [Yes].
B Acknowledge the [Remove Shared File?] dialog box.

E When the uninstallation is complete, click [OK].
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Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

5] Preparation
The target machine must be turned on before starting the installation process.

ﬂ Install the printer driver of the machine you want to use.

g From the [Printers] window, click the icon of the machine. On the [File]
menu, click [Properties].

B Click the [Ports] tab, and then click [Add Port].
The [Add Port] dialog box appears.

ﬂ Click [SmartNetMonitor] from the list, and then click [New Port...].
The [Select Printer] dialog box appears and printers.
The displayed items are as follows:
Model Name: The model name of the printer.
Printer Name: The name of the printer.
Comment: Additional information about the printer.
Address: The IP address of the printer.

B Select the machine.

TCP/IP

@ Click [TCP/IP], and then click [search].
A list of printers that can be printed to by the TCP/IP protocol appears.
@ Click the machine you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.
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NetBEUI

@ Click [NetBEUI], and then click [search].
A list of printers that can be printed by the NetBEUI protocol appears.
@ Click the machine you want to use, and then click [OK].

& Note

O Printers that respond to a broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the system configuration list. For information about the printing of
the system configuration list, see Printer Reference 2.

O You cannot print to printers beyond routers.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the machine, type "http://machine's-ip-ad-
dress/printer" or "ipp://machine's-ip-address/printer" in the [Printer URL]
field.

(192.168.15.16 is an example IP address.)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© If necessary, type a name to distinguish printers in [IPP Port Name]. Type
a name different from any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

/O Reference

For more information about these settings, see SmartNetMonitor for
Client Help.

@ Click [OK].

A ciick [ox.

t ciick [Close].

8 Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [OK].

This completes the settings.

To print, select the printer specified. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.
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Changing Port Settings

Follow these steps to change SmartNetMonitor for Client settings, such as
TCP/IP, the proxy server and IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

ﬂ From the [Printers] window, click the icon of the machine you want to use.
On the [File] menu, click [Properties].
ﬂ Click the [Ports] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.
* For TCP/IP protocol, you can configure Timeout Settings.
* For IPP, you can configure User Settings or Proxy Settings.
A Reference

For more information about these settings, see SmartNetMonitor for Client
Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
NT.

@ Note

O The following procedure assumes that the printer drivers have already been
installed. This is the procedure to change the printer port to LPR.

O The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocols, see p.43 “Configuring TCP/IP
and IPP for Printing”.

B ciicx [Start], point to [Settings], and then click [Printers].

g Click the icon of the machine you want to use. On the [File] menu, click
[Properties].

B Click the [Ports] tab, and then click [Add Port].
ﬂ In the [Available Printer Ports:] box, click “LPR Port”, and then click [New Port].

& Note

O If “LPR Port” does not appear, “Microsoft TCP/IP Printing” has not been
installed.

B Type the IP address of the Network Interface Board into the [Name or address
of server providing Ipd:] box.

B Type “1p” into the [Name of printer or print queue on that server:] box, and click
[OK].

t click [Close].

B Make sure that the port name is displayed in the [Print to the following port(s)]
box and the check box is selected, and then click [OK].



Setting Up a Client Computer

Setting Up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000/ Windows XP, Windows NT Server or Windows NT Work-
station as a print server.

When using a Windows 2000/ Windows XP or Windows NT print server, select
a shared printer on Windows 2000 or Windows NT.

Windows 2000, Windows XP
or Windows NT Print Server

(7]
N
Windows NT 4.0

NT40NTPOO1E

@ Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

Use the [Printers] window to set up the machine.
B cicx [Start], point to [Settings], and then click [Printers].

g Double-click the [Add Printer] icon.
This launches the Add Printer Wizard.

B Click [Network printer server] and click [Next >].

ﬂ In the [Shared Printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.
B Click the machine you want to use and click [OK].

@ Note

O If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and follow the in-
structions on the screen.

O There is a Windows NT printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.
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B Select whether to use this machine as the default printer, and click [Next >].

ﬂ After the installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.



e
5. NetWare Configuration

This chapter describes how to configure the machine to use as a print server or
a remote printer in a NetWare environment.

& Note

O The NetWare settings are performed in Web Status Monitor or SmartNet-
Monitor for Admin. See the corresponding online Help for details.

Installing the NIB Setup Tool

A utility called the NIB Setup Tool is provided to configure the machine to work
in a network environment. This section describes how to install the SmartNet-
Monitor for Admin, and how to run the NIB Setup Tool.

? Limitation

O The NIB Setup Tool is supported to work with the following operating sys-
tems.

¢ Microsoft Windows 95/98/Me
e Microsoft Windows 2000/ Microsoft Windows XP
e Microsoft Windows NT 4.0

Installing SmartNetMonitor for Admin

Follow these steps to install the SmartNetMonitor for Admin.

5] Preparation

You should install the SmartNetMonitor for Admin on the computer. If you
install the SmartNetMonitor for Admin from a file server or run it via the net-
work, the SmartNetMonitor for Admin might not work correctly.

Make sure to close all applications before starting the installation procedure.
ﬂ Close all the applications that are currently running.

g Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

B Open [Control Panel], and double-click the [Add/Remove Programs] icon.
ﬂ On the [Install/Uninstall] tab, click [Install].
B Click [Next >].
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B In the [Command line for installation program] box, type the name of the CD-ROM
drive followed by “\NETWORK\NETMON\ADMIN\DISK1I\SET-
UP.EXE” (do not include the quotation marks), and then click [Finish].

& Note

O An example would be “D:\NETWORK\NETMON\ ADMIN\DISKI\SET-
UP.EXE” when the CD-ROM drive name is “D”.

ﬂ From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

B After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.

Running the NIB Setup Tool

ﬂ Click [Start], point to [Programs], and then click [NIB Setup Tool] in the [Smart-
NetMonitor for Admin] program folder.



Quick Setup Using the NIB Setup Tool Wizard

Quick Setup Using the NIB Setup Tool
Wizard

With the NIB Setup Tool, you can easily set up a NetWare printing environment.

p Reference

For more information about installing the NIB Setup Tool, see p.55 “Installing
the NIB Setup Tool”.

You can select [Wizard] or [Property Sheet] as an installation method.

When you configure the Network Interface Board for the first time, use the Wiz-
ard method.

If you want to use the Property Sheet method, see p.60 “NetWare 3.x - Advanced
Settings” or p.66 “NetWare 4.x, 5/5.1 - Advanced Settings”.

@ Note

O This section assumes that NetWare is functional and that the necessary envi-
ronment for NetWare Print Services is available.

O If you configure the Network Interface Board in a NetWare environment us-
ing the NIB Setup Tool, you should install the client software released from
Novell in the following cases.

* Windows 95/98/Me in NDS mode configuration
e Windows NT 4.0 in NDS mode configuration

¢ Windows NT 4.0 in Bindery mode configuration
¢ Windows 2000 in NDS mode configuration

¢ Windows 2000 in Bindery mode configuration

¢ Windows XP in NDS mode configuration

* Windows XP in Bindery mode configuration

ﬂ Log on to the Netware file server or the NDS tree as an Admin or Admin
equivalent.

g Run the NIB Setup Tool.

A Reference
= p.56 “Running the NIB Setup Tool”

B Click [Wizard] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

B Click [IPX protocol].
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B Click to select the IPX address of the Network Interface Board you are con-
figuring, and then click [Next >].

@ Note

O If you do not know which Network Interface Board you are configuring,
print a system configuration list to check the MAC address (Network ad-
dress).

B Make sure that the MAC address and IPX address are correct, and click [Fin-
ish].
ﬂ Type the print server name into the [Device Name] box, and click [Next >].

The default setting is “RDP_" followed by the 6 digit serial number. We rec-
ommend that you change it to something that is easier to remember or some-
thing based on the structure of the network.

8 In a dialog box for selecting a network environment, click to select the [Net-
Ware] check box and click to clear the [TCP/IP] check box.

B Click [Next >].
A dialog box for configuring the NetWare environment appears.

[E Select [Bindery] when printing under Bindery mode, or select [NDS] when
printing under NDS mode.

When you are using NetWare version 4.x, you should select [NDS].

ﬂ] If you selected [Bindery], type into the [File Server Name:] box the name of the
file server in which a print server is to be created.

After clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

[ﬂ If you selected [NDS], type into the [Tree:] box the name of the NDS tree in
which the print server is created, and type the context into the [Context:] box.

Clicking [Browse], you can select an NDS tree and an NDS context among
those listed in the [Browse] dialog boxes.

As a context, object names are typed from a lower object and divided by a pe-
riod. For example, if you want to create a print server into NET under DS,
type “NET.DS”.

B click Next >].
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m Type the name of the machine into the [Printer Name] box, and the name of
the print queue into the [Print Queue Name] box.

The default setting for Printer Name is “Print Server Name” followed by “_1"
and for Print Queue Name is “Print Server Name” followed by “_Q” (quota-
tion marks are not included). You can change them if necessary.

[B If you have selected the NDS mode, type the volume of the print queue into
the [Queue Volume] box.

Clicking [Browse], you can select one of those shown in the [Browse] dialog
box.

B crick Next 1.
A dialog box to acknowledge the printing environment appears.

m Check the environment, and then click [Next >].
If you want to change the settings, click [< Back] and make the settings again.

Clicking [Next >], the NIB Setup Tool automatically creates the Print Server,
the Printer, and the Print Queue in the NetWare network.

iE After the confirmation dialog box appears, select [Quit] and click [Finish] to
exit the NIB Setup Tool.
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NetWare 3.x - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure the machine in the NetWare 3.x en-
vironment.

Basic Procedure

(Install the NIB Setup Tool |

Print Server Remote Printer

(Configure the Network Interface Board ]

(Configure the NetWare )

v

5] Preparation
The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. = p.57 “Quick Setup Using the NIB Setup Tool Wizard”

Start the print server

NW312-G-011

@ Note

O This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.
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Setting Up as a Print Server

ﬂ Log on to the file server as a Supervisor or a Supervisor equivalent.
ﬂ Run the NIB Setup Tool.

A Reference
= p.56 “Running the NIB Setup Tool”

B Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

B Click [IPX protocol].

B Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

& Note

O If you do not know which Network Interface Board you are configuring,
see the system configuration list to check the MAC address (Network Ad-
dress).

B Make sure that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

B Click the [General] tab, and type the name of the print server into the [Device
Name] box.

g Click the [NetWare] tab, and make the following settings.

@ Select [Bindery].

In the [File Server Name:] box, type the name of the file server in which a
) € YP
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

© Click [OK] to close the property sheet.
O After the confirmation dialog box appears, click [OK].

[m On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

ﬂ] Type “PCONSOLE” from the command prompt.
F:> PCONSOLE
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m Create a print queue as follows:

& Note
O If you use a currently defined print queue, go to step {B.

@ From the [Available Options] menu, select [Print Queue Information] and press
the [ENTER] key.

@ Press the [INSERT) key and type a print queue name.
© Press the [ESC] key to return to the [Available Options] menu.

[B Create a printer as follows:

@ From the [Available Options] menu, select [Print Server Information] and press
the [ENTER] key.

@ To create a new print server, press the [INSERT] key and type a print
server name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

ﬂlmportant
O Use the same name as that specified in the NIB Setup Tool. (Step [J).

© From the [Print Server Information] menu, select [Print Server Configuration].
@ From the [Print Server Configuration] menu, select [Printer Configuration].
@ Select the printer which is indicated as “Not Installed”.

O 1f you want to change the name of the printer, type a new name.

A name “Printer x” is assigned to the printer. “x” stands for the number of
the selected printer.

@ For type, select [Remote Other/Unknown].

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

@ Press the [ESC] key, and click [Yes] in the confirmation dialog box.
© Press the [ESC] key to return to the [Print Server Configuration] menu.

[ﬂ Assign print queues to the created printer as follows:
@ From the [Print Server Configuration] menu, select [Queues Serviced By Printer].
@ Select the printer created in step [B.
© Press the [INSERT) key to select a queue serviced by the printer.

& Note
O You can select more than one queue at a time.

O Follow the instructions on the screen to make other necessary settings.

When you have finished the previous steps, make sure that the queues are
assigned.
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[B Press the [ESC] key until “Exit?” appears, and select [Yes] to exit PCON-
SOLE.

@ Note

O To make sure that the machine is correctly configured, type the following
from the command prompt.

F:> USERLIST

O If the machine works as configured, the name of the print server appears
as an attached user.

Setting Up as a Remote Printer

ﬂ Log on to the file server as a Supervisor or a Supervisor equivalent.
g Run the NIB Setup Tool.

A Reference
= p.56 “Running the NIB Setup Tool”

B Ciick [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

B Click [IPX protocol].

B Click the IPX address of the Network Interface Board to be configured, and
click [Next >].

@ Note

O If you do not know which Network Interface Board you are configuring,
see the system configuration list to check the MAC address (Network Ad-
dress).

E Make sure that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

8 Click the [General] tab, and type the name of the print server into the [Device
Name] box.
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g Click the [NetWare] tab, and make the following settings.
@ In the [Print Server Name:] box, type the name of the print server.

@ In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

© In the [Print Server Operation Mode] group, click [As Remote Printer].
O In the [Remote Printer No.] box, type the printer number.

i@klmportant
O Use the same printer number as that to be created in the print server.

@ Click [OK] to close the property sheet.
O After the confirmation dialog box appears, click [OK].

[E On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

ﬂ] Type “PCONSOLE” from the command prompt.
F:> PCONSOLE

m Create a print queue as follows:

& Note
O If you use a currently defined print queue, go to step {B.

@ From the [Available Options] menu, select [Print Queue Information] and press
the [ENTER] key.

@ Press the [INSERT) key and type a print queue name.
© Press the [ESC] key to return to the [Available Options] menu.

[B Create a printer as follows.

@ From the [Available Options] menu, select [Print Server Information] and press
the [ENTER] key.

@ To create a new print server, press the [INSERT] key and type a print
server name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

ﬂlmportant
O Use the same name as that specified in the NIB Setup Tool. (Step [J).

© From the [Print Server Information] menu, select [Print Server Configuration].
@ From the [Print Server Configuration] menu, select [Printer Configuration].
@ Select the printer which is indicated as “Not Installed”.

ﬂlmportant

O Use the same number as that specified as Remote Printer No. using the
NIB Setup Tool. (Step (J-@).
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O Type a new name, if you change the name of the printer, .

A name “Printer x” is assigned to the printer. x stands for the number of
the selected printer.

@ Select [Remote Parallel, LPT1,] for type.

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

@ Press the [ESC] key, and click [Yes] in the confirmation dialog box.
© Press the [ESC] key to return to [Print Server Configuration Menul].

[ﬂ Assign print queues to the created printer as follows:
@ From [Print Server Configuration Menu], select [Queues Serviced By Printer].
@ Select the printer created in step [B.
© Press the [INSERT] key to select a queue serviced by the printer.

& Note
O You can select more than one queue at a time.

O Follow the instructions on the screen to make other necessary settings.

When you have finished the above steps, make sure that the queues are as-
signed.

[B Press the [ESC] key until “Exit?” appears, and select [Yes] to exit PCON-
SOLE.

[@ Start the print server by typing the following from the console of the Net-
Ware Server.

If it is running, restart it after exiting it.
% To exit

CAREE: unload pserver
% To start

CAREE: load pserver print server name

& Note
O If the machine works as configured, “Waiting for job” appears.
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NetWare 4.x, 5/5.1 - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure it in the NetWare 4.x, 5/5.1 environ-
ment.

< To use NetWare 5/5.1

¢ If you use Pure IP, configure the machine to use the TCP/IP protocol. For
more information about how to make the settings, see Printer Reference 1.

Basic Procedure

(Install the NIB Setup Tool )

Print Server Remote Printer

(Configure the Network Interface Board ]

(Configure the NetWare )

v

5] Preparation

The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. = p.57 “Quick Setup Using the NIB Setup Tool Wizard”

Start the print server

NW41-G-010

& Note

O This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

O You should install the client software released from Novell in Windows be-
fore running the NIB Setup Tool for configuring in NDS mode or using Win-
dows NT 4.0.
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Setting Up as a Print Server

ﬂlmportant

O You can set up the print server using the NDS or Bindery mode in NetWare
4.x,5/5.1. The following procedure is for setting up the print server using the
NDS mode in NetWare 4.1. When you set up the print server using the Bind-
ery mode, use the NIB Setup Tool Wizard. = p.57 “Quick Setup Using the
NIB Setup Tool Wizard”.

& Note

O If you use Pure IP in NetWare 5/5.1, follow the procedure on p.70 “Using
Pure IP in the NetWare 5/5.1 environment”.

ﬂ Log on to the file server as an Admin or an Admin equivalent.
ﬂ Run the NIB Setup Tool.

A Reference
= p.56 “Running the NIB Setup Tool”

B Click [Property Sheet] and click [OK].
The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

B ciick [1PX protocol].

B Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

@ Note

O If you do not know which Network Interface Board you are configuring,
see the system configuration list to check the MAC address (Network Ad-
dress).

B Make sure that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

B Click the [General] tab, and type the name of the print server into the [Device
Name] box.
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g Click the [NetWare] tab, and make the following settings.
© In the [Print Sever Name:] box, type the name of the print sever.

@ In the [File Sever Name:] box, type the name of the file sever in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

© In the [NDS Context:] box, type the context in which the print server is to
be created.

Click [Browse] to select a context among those listed in the [Browse] dialog
box.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type “NET.DS”.

O Click [OK] to close the property sheet.
@ After the confirmation dialog box appears, click [OK].

[E On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.
ﬂ] From Windows, run NWAdmin.

p Reference

For more information about NWAdmin, see the documentation that comes
with the NetWare.

m Create a print queue as follows:

@ Select the container object the print queue is located in among those in
the directory tree, and click [Create] on the [Object] menu.

@ In the [Class of new object] box, click “Print Queue”, and click [OK].
© In the [Print Queue name] box, type the name of the print queue.
O In the [Print Queue volume] box, click the [Browse] button.

@ In the [Available objects] box, click the volume in which the print queue is
created, and click [OK].

O Check the settings, and then click [Create].
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[B Create a printer as follows:

@ Select the container object the printer is located in, and click [Create] on
the [Object] menu.

@ In the [Class of new object] box, click “Printer”, and click [OK]. When you
are using NetWare 5/5.1, click “Printer (Non NDPS)”.

© In the [Printer name] box, type the name of the printer.
O Select the [Define additional properties] check box, and click [Create].

[ﬂ Assign print queues to the created printer as follows:
@ Click [Assignments], and click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the queue created in step ff}, and click
[OK].

© Click [Configuration], and in the [Printer type] box, select [Parallel] using the
drop-down menu, and then click [Communication].

O Click [Manual load] in the [Communication type] group, and click [OK].
@ Check the settings, and then click [OK].

[B Create a print server as follows:

@ Select the context specified using the NIB Setup Tool (step [J-@), and on
the [Object] menu, click [Create].

@ In the [Class of new object] box, click “Print Server”, and click [OK]. When
you are using NetWare 5/5.1, click “Print Server (Non NDPS)”.

© In the [Print Server name] box, type the name of the print server.

ﬂlmportant
O Use the same name as that specified using the NIB Setup Tool. (Step B)

O Select the [Define additional properties] check box, and click [Create].

m Assign the printer to the created print server as follows:
@ Click [Assignments], and click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the printer created in step [, and click
[OK].

© Check the settings, and then click [OK].

& Note

O If the machine works as configured, the name of the print server ap-
pears as an attached user.
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Using Pure IP in the NetWare 5/5.1 environment

ﬂ Log on to the file server as an Admin or an Admin equivalent.
g Run the NIB Setup Tool.

A Reference
= p.56 “Running the NIB Setup Tool”

B Click [Property Sheet] and click [OK].
The [Network board list] dialog box appears.

B ciick [TCPAP protocol].

B Click the IP address of the Network Interface Board which is to be config-
ured, and then click [Next >].

@ Note

O If you do not know which Network Interface Board you are configuring, see
the system configuration list to check the MAC address (Network Address).

E Make sure that the MAC address and IP address are correct, and click [Finish].
The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

B Click the [General] tab, and type the name of the print server into the [Device
Name:] box.

g Click the [NetWare] tab, and make the following settings.
@ In the [Print Server Name:] box, type the name of the print server.

@ In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse File
Server] dialog box.

© In the [NDS Context:] box, type the context of the print server.

Click [Browse] to select an NDS tree and an NDS context among those listed
in the [Browse Context] dialog box.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type “NET.DS”.
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O In the [Print Server Operation Mode] group, click [As Print Server].
@ Click [OK] to close the property sheet.
O After the confirmation dialog box appears, click [OK].

[E On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.
After this step, go to step {f] on p.67 “Setting Up as a Print Server”.

Setting Up as a Remote Printer

ﬂ Log on to the file server as an Admin or an Admin equivalent.
g Run the NIB Setup Tool.

A Reference
= p.56 “Running the NIB Setup Tool”

B Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

B Click [IPX protocol].

B Click the IPX address of the Network Interface Board to be configured, and
click [Next >].

& Note

O If you do not know which Network Interface Board you are configuring,
see the system configuration list to check the MAC address (Network Ad-
dress).

B Make sure that the MAC address and IPX address are correct, and click [Fin-
ish].
The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

B Click the [General] tab, and type the name of the print server into the [Device
Name] box.

g Click the [NetWare] tab, and make the following settings.

@ In the [Print Server Name:] box, type the name of the print server.

@ In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.
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© In the [NDS Context:] box, type the context in which the print server is to
be created.

Click [Browse] to select a context among those listed in the [Browse] dialog
box.

As a context, object names are typed from a lower level object and divided
by a period. For example, if you want to create a print server into NET un-
der DS, type “NET.DS”.

O In the [Print Server Operation Mode] group, click [As Remote Printer].
@ In the [Remote Printer No.] box, type the printer number.

ﬂlmportant
O Use the same printer number as that of the printer to be created in the

print server.
O Click [OK] to close the property sheet.
@ After the confirmation dialog box appears, click [OK].

[m On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.
m From Windows, run NWAdmin.

/O Reference

For more information about NWAdmin, see the documentation that comes
with the NetWare.

m Create a print queue as follows:

@ Select the container object the print queue is located in among those in
the directory tree, and click [Create] on the [Object] menu.

@ In the [Class of new object] box, click “Print Queue”, and click [OK].
© In the [Print Queue name] box, type the name of the print queue.
O In the [Print Queue Volume] box, click [Browse] button.

@ In the [Available objects] box, click the volume in which the print queue is
created, and click [OK].

O Check the settings, and then click [Create].

[B Create a printer as follows:

@ Select the container object the printer is located in, and click [Create] in
the [Object] menu.

@ In the [Class of new object] box, click “Printer”, and click [OK]. When you
are using NetWare 5/5.1, click “Printer (Non NDPS)”.
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© In the [Printer name] box, type the name of the printer.
O Select the [Define additional properties] check box, and click [Create].

[ﬂ Assign print queues to the created printer as follows:
© Click [Assignments], and click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the queue created in step ), and click
[OK].

© Click [Configuration], and in the [Printer type] box, select [Parallel] using the
drop-down menu, and then click [Communication].

O Click [Manual load] in the [Communication type] group, and click [OK].
@ Check the settings, and then click [OK].

[B Create a print server as follows:

@ Select the context specified using the NIB Setup Tool (Step (J-@), and on
the [Object] menu, click [Create].

@ In the [Class of new object] box, click “Print Server”, and click [OK]. When
you are using NetWare 5/5.1, click “Print Server (Non NDPS)”.

© In the [Print Server name] box, type the name of the print server.

ﬂlmportant
O Use the same name as that specified using the NIB Setup Tool. (Step ).

O Select the [Define additional properties] check box, and click [Create].

m Assign the printer to the created print server as follows:
@ Click [Assignments], and click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the queue created in the step B, and
click [OK].

© In the [Printers] group, click the printer assigned in step @, and click
[Printer Number].

O Type the printer number and click [OK].

ﬂlmportant
O Use the same number as that specified as Remote Printer No. using the

NIB Setup Tool. (Step [J-@).
@ Check the settings, and then click [OK].

m Start the print server by typing the following from the console of the Net-
Ware Server.

If it is running, restart it after exiting it.

< To exit
CAREE: unload pserver

% To start
CAREE: load pserver print server name
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Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

& Note

O This section assumes that the client has NetWare client applications installed
and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setting up proce-
dure.

Windows 95/98/Me

Follow the procedure to set up a Windows 95/98/Me client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Install the printer driver you want to use as “Local printer”.

A Reference
For more information about installing the printer driver, see Printer Refer-
ence 1.

& Note

O Any port can be selected during the installation, however, LPT1 is recom-
mended.

B Click [Start], point to [Settings], and then click [Printers].

B In the [Printers] window, click the icon of the machine you want to use.
B On the [File] menu, click [Properties].

B click the [Details] tab, and click [Add Port].

[ ciick [Network] and click [Browse].

ﬂ On the network tree, double-click the name of the file server.

The queues are displayed.
B Click the queue you want to print, and click [OK].

B click [0k,
In the [Print to the following port:] box, a network path to the printer appears.

[m Click [OK] to close the Printer Properties, and again, open it.
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[ Click the [Printer Settings] tab.
m Select to clear the [Form feed] and [Enable banner] check boxes.

@ Note

O You should not select these boxes because they should be specified using
the printer driver. If they are selected, the printer might not print correctly.

When using the PostScript printer driver

Follow these steps to set up for the PostScript printer driver.
@ Click the [PostScript] tab.
@ Click [Advanced].

@ Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check
boxes.

[B Click [OK] to close the Printer Properties.

Windows 2000/Windows XP

Follow the procedure to set up a Windows 2000/ Windows XP client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Double-click the [My Network Places] icon on the desktop and navigate to the
queue you want to use, and then double-click it.

The printers dialog box appears.
B click (No).
B Close all the applications that are currently running.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

B Install the printer driver.

A Reference
For more information about installing the printer driver, see Printer Refer-
ence 1.

E From the [Port] list, select the queue you selected in step fJ, and click [Next >].

ﬂ Follow the instructions on the screen to complete the installation of the
printer driver.
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Windows NT 4.0

Follow the procedure to set up a Windows NT 4.0 client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Double-click the [Network Neighborhood] icon on the desktop and navigate to
the queue you want to use, and then double-click it.

The [Printers] dialog box appears.
B click Noj.
B Close all the applications that are currently running.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

B Install the printer driver.

A Reference
For more information about installing the printer driver, see Printer Refer-
ence 1.

E From the [Port] list, select the queue you selected in step [J, and click [Next >].

ﬂ Follow the instructions on the screen to complete the installation of the
printer driver.



Configuring Macintosh

This section describes how to configure a Macintosh computer to use EtherTalk.
The actual procedures to configure a Macintosh may vary depending on the ver-
sion of Mac OS. The following procedure describes how to configure Mac OS 9.1
and Mac OS X version 10.1. If you are using other version of Mac OS and Mac
OS X, see the manual that comes with your version of Mac OS and Mac OS X for
more information.

Basic Procedure

Change to EtherTalk J

(
(Configure the printer j
(

Change the printer namej

Change the zone

MAC-G-010

? Limitation

O Use PostScript 3, to print from a Macintosh.
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Changing to EtherTalk

The following procedure is for configuring a Macintosh computer to use
EtherTalk.

p Reference

For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

Mac OS

ﬂ Open [Control Panels], and double-click the [AppleTalk] icon.

g From the [Connect via:] pop-up menu, select “Ethernet”.

B If you change zones, select a name from the [Current zone:] pop-up menu.
ﬂ Close the [AppleTalk] control panels.

B Restart the Macintosh.

Mac OS X

5] Preparation

You need an administrator name and a password (phrase). For more informa-
tion, consult your administrator.

ﬂ Open [System Preference], and then click the [Network] icon.
B Click the [AppleTalk] tab.
B If you change zones, select a name from the [AppleTalk Zone:] pop-up menu.

ﬂ When the setting is complete, click [Apply Now].

Configuring the Printer

Use the control panel to activate the EtherTalk protocol. (The default is active.)

p Reference
For more information about configuration, see Printer Reference 1.
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Changing the Printer Name

If the network has several same model printers, the names will be the same.
Printers that have the same name will have their names changed slightly in the
Chooser on Mac OS or Printer list on Mac OS X. For example, three printers
named “printer” will appear in the chooser as “printer0”, “printerl” and
“printer2”.

Use applications such as Apple Printer Utility or LaserWriter Utility to change
printer names in the Macintosh EtherTalk environment. These utilities are dis-
tributed by Apple Computer, Inc.

Changing the Zone

It may be necessary to change the zone configuration.

Use applications such as Apple Printer Utility or LaserWriter Utility to change
the zone configuration in the Macintosh EtherTalk environment. These utilities
are distributed by Apple Computer, Inc.

& Note

O If the Macintosh is configured to use TCP/IP, you can change the zone con-
figuration with a Web Browser. = p.84 “Configuring the Network Interface
Board with a Web Browser”

Follow these steps to use the Apple Printer Utility.
@ Insert the CD-ROM into the CD-ROM drive.
@ Copy the “Zone Name.ps” file in the “Zone Name” folder to the hard disk.

® Open the copied “Zone Name.ps” file using a text editor, and change “New-
Zone”, which is in the second line from the bottom, to the name of the new
zone.
%!PS-Adobe2.0
%%Title: Changing Zone (EtherNet only)
%% CreationDate: Tue Dec 16 1997
%%EndComments
true O startjob not {ERROR]} if
(%EtherTalk%) << /EtherTalkZone (NewZone) >> setdevparams
%%EQOF

@ Save “Zone Name.ps”.

® Run the Apple Printer Utility, and select the printer for which the new zone
name is to be used.

® Select [Send PostScript File] in the [Utilities] menu, and send “Zone Name.ps” to
the printer.
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/. Appendix

Using SmartNetMonitor for Admin

Using SmartNetMonitor for Admin, you can not only monitor the status of net-
work printers, but also change the configuration of the Network Interface Board
using the TCP/IP protocol or IPX/SPX protocol.

SmartNetMonitor for Admin can do the following.

¢ Limit the settings available from the control panel, and disable changes made
to some items.

¢ Enable selecting the paper type loaded in the printer.

¢ Check information about printing, paper exhaustion, and such on the compu-
ter.

* Monitor multiple printers at the same time. When there are many printers,
you can create groups and classify the printers to facilitate management.

* Check the printer's network settings and detailed information of devices.
¢ Enable you to change the printer's network settings.

¢ Check the number of pages printed for each computer using the user codes.

oS Protocol Stack

Microsoft Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetWare network client provided with Windows 95/98
Novell Client for Windows 95/98

Microsoft Windows 2000 TCP/IP provided with Windows 2000
IPX/SPX provided with Windows 2000
NetWare Client provided with Windows 2000
Novell Client for Windows NT /2000

Microsoft Windows XP TCP/IP provided with Windows XP
IPX/SPX provided with Windows XP
Microsoft Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT
Client Service for NetWare provided with Windows NT
Novell Client for Windows NT /2000

& Note
O Select the appropriate protocol stack for your operating system.
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Changing the Network Interface Board Configuration

ﬂ Run SmartNetMonitor for Admin.

ﬂ Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or
[IPX/SPX]. A list of printers appears.

& Note
O Select the protocol of the printer for which you want to change the config-
uration.

B On the list, select a printer for which you want to change the configuration.

O From the [Tools] menu, select [NIB Setup Tool].
The NIB Setup Tool starts up.

B seiect [Wizard] or [Property Sheet], and then click [Next].
* When configuring the Network Interface Board for the first time, select
[Wizard].
* When changing the configuration of the Network Interface Board or con-
figuring it in detail, select [Property Sheet].

Selecting [Wizard]

@ Fill in the necessary items, and then click [Next].

Selecting [Property Sheet]

© A configuration list appears on the dialog box.
For more information about each item on the dialog box, see Help.



Using SmartNetMonitor for Admin

Managing the printed number of pages

ﬂ Run SmartNetMonitor for Admin.

ﬂ Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or
[IPX/SPX].

A list of printers appears.

@ Note

O Select the protocol of the printer for which you want to change the config-
uration.

B On the list, select a printer whose statistics information you want to man-
age.

ﬂ From the [Tools] menu, select [User Management Tool].
A dialog box prompting you to type a password appears.

B Type the password, and then click [OK].

& Note
O The factory default password is "password".

The User Code Maintenance Tool starts up.

For more information about using the User Management Tool, see SmartNet-
Monitor for Admin Help.
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Configuring the Network Interface Board

with a Web Browser

The Network Interface Board functions as a Web server in addition to allowing
the machine to function as a network printer. You can use a Web Browser to
view the printer status and configure the Network Interface Board.

< Configuring the machine

This requires the TCP/IP protocol to be installed. After the machine has been
configured to use the TCP/IP protocol, it will be possible to adjust the settings

using a Web Browser.

p Reference

For more information about configuring the machine to use the TCP/IP

protocol, see Printer Reference 2.

< Operating system browser requirements

oS

Browser

Windows 95/98/Me

Windows 2000

Windows XP

Windows NT 4.0

MacOS57.6.1 ~9.2
Mac OS X

Solaris 2.5 ~ 2.6

Microsoft Internet Explorer 3.02/4.0 or later
Netscape Navigator 3.0/4.0 or later

? Limitation

O Sometimes after clicking [Back] , the previous page may not appear. In this

case, click [Refresh] or [Reload] .

O The text on the screen may disappear or be aligned incorrectly if the font
size settings of the browser are too large. It is recommended that you use
a font size equal to or smaller than “10 point” with Netscape Navigator,
and “Medium” or smaller with Internet Explorer.
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Going to the Top Page

After launching the Web Browser, type the IP address of the machine. See the
example below. This example is for the English version.

http://192.168.15.16/

(In this example, the IP address of the Network Interface Board is 192.168.15.16.)

@ Note

O If a DNS server is used on the network, you can type the host name as an URL.
For example, http:/ /webmonitor.netprinter.com/. In order to do this, you
must register the IP address and host name of the Network Interface Board
with the DNS server. Consult the network administrator for information

about how to do this.

O If you want to use any equipment in the proxy server network environment,
stop the proxy server or temporarily stop access to the proxy server from the

equipment.

Comment

Status

Rmver Mame: Nt Printer
Fifth Floor
Ready

1. Header Buttons

You can register favorite URLs with
[URL]. To view the Help section, click
[Help].

ﬂlmportant

O When connecting via a dial-up
connection, please be aware that
there will be a communication
charge as you are logging onto the
Internet.

& Note

O Help is stored in the following folder
on the CD-ROM in HTML format. The
third folder, "(Language)" may be sub-
stituted by an appropriate language
name.

\HELP\WSMHLP\ (Language) \

WEB-010-G

2. Menu Buttons

Buttons to configure the Network Inter-
face Board and confirm the status of the
machine.

@ Note

O When you click [Network Config], a dia-
log box appears requesting the user
name and the password. Type only
the password in this dialog box. The
factory default password is “pass-
word”.

O The password is the same as that used
for remote maintenance and that used
in the NIB Setup Tool. If you change a
password with the Web Browser, the
other passwords are also changed.

3. Status

Displays the name and comments of the
Network Interface Board, and the printer
status.
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Verifying the Network Interface Board Settings

ﬂ Start the Web browser.

ﬂPoint your browser at the URL or IP address of the printer (e.g. ht-
tp /XXX XXX XXX XXX where the Xs are the numbers of the IP address).

The status of the printer you chose appears on the Web browser.

B Click [Config. Reference].
The dialog box for entering the password and user name is displayed.

ﬂ Click the item you want to check.
The following items can be checked:

< [General]
Shows the general settings for the machine.

% [TCP/IP]
Shows the TCP /IP-related settings for the Network Interface Board.

< [NetWare]
Shows the settings for printing in a NetWare environment.

< [AppleTalk]
Shows the Network Interface Board settings related to the AppleTalk protocol.

< [NetBEUI]
Shows the Network Interface Board settings related to the NetBEUI protocol.

iQ'f‘Linking the address (URL) to the [Help] button

You can link the address (URL) of the [Help] button to the Help files on the com-
puter or on a Web server.

@ Copy the Help files on the CD-ROM to the desired location. The Help files are
located in folders labeled with abbreviated language names. For example,
English Help files are in the [EN] folder. Be sure to copy the entire [EN] folder
to the new location.

® Using a Web Browser, navigate to the Top Page and click [Network config.].
® Type your password, (it is not necessary to type a user name) and click [OK].

@ Type the path to the Help files in the [Help URL] box.
If you copied the Help files to "C:\HELP\EN", type "file://C:/HELP/". For
example if you copied the files to a web server and the index URL is "ht-
tp://a.b.c.d/HELP/EN/index.html", type "http://a.b.c.d/HELP/".

® Click [Apply].
When a warning message appears, select to continue configuration.



Configuring the Network Interface Board with a Web Browser

Configuring the Network Interface Board Settings

ﬂ Start the Web browser.

ﬂ Point your browser at the URL or IP address of the printer (e.g.
http:// XXX XXX XXX. XXX where the Xs are the number of the IP address).
The status of the printer you chose appears on the Web browser.

B ciick [Network Config].
The dialog box for entering the password and user name is displayed.

ﬂ Enter your user name and password, and then click [OK].

To use the factory default account, enter no user name and type "password"
for the password.

B Click the item you want to configure, and then make all the settings.

The following items can be configured:

< [General]
Configure the general settings for the machine here.

< [TCP/IP]
Configure the TCP /IP-related settings for the Network Interface Board.

+ [SNMP]
Configure the appropriate community settings here. Up to 10 types of
community names can be registered.

< [NetWare]
Configure the settings for printing in a NetWare environment here.

< [AppleTalk]
Configure the Network Interface Board settings related to the AppleTalk
protocol.

< [NetBEUI]
Configure the Network Interface Board settings related to the NetBEUI
protocol here.

< [IPP Authentication]
If using the IPP protocol, configure the authentication settings for printing
here.

< [Password]
Enter the password to change the network and machine settings or delete
spooled print jobs.
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Monitoring and Configuring the Printer

Changing Names and Comments

You can change printer names and make comments for printers to easily identify
the printers listed on SmartNetMonitor for Client.

The following utilities are used to change printer names and comments.

< SmartNetMonitor for Admin
Allows you to change names and comments when the TCP/IP protocol or
IPX/SPX protocol is available. You can install SmartNetMonitor for Admin
from the CD-ROM that comes with the printer. For more information about
installing SmartNetMonitor for Admin, see the Setup Guide.

< Web Browser
Allows you to change names and comments when the TCP/IP protocol is
available.

& Note

O Each of the names, one for the TCP/IP protocol form (printer name) and
NetBEUI protocol form, is changed individually. However comments are
common to both of them.

O The factory default name consists of "RNP" and the last 3 bytes of the MAC
address on the Network Interface Board. For example, when the MAC ad-
dress is 00:00:74:62:7D:D5, the factory default name is "RNP627DD5".
Comments are not configured.

SmartNetMonitor for Admin

ﬂ Run SmartNetMonitor for Admin.

g Click the [Group] menu, point to [Open LAN], and select [TCP/IP] or [IPX/SPX].
A list of printers appears.

@ Note

O Select the protocol of the printer for which you want to change the config-
uration.

B On the list, select a printer whose Network Interface Board configuration
you want to change.

O £rom the [Tools] menu, select [NIB Setup Tool].
The NIB Setup Tool starts up.
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B select [Property Sheet], and then click [OK].

TCP/IP

@ Click the [General] tab, and then type the device name into the [Device
Name] box and a comment into the [Comment] box.

* In the [Device Name] box, type the name of the printer using less than 13
characters. The factory default name consists of "RNP" and the last 3
bytes of the MAC address on the Network Interface Board. For example,
when the MAC address is 00:00:74:62:7D:D5, the factory default name is
"RNP627DD5". No name of 9 characters is permitted if the prefix is
"RNP". Also, when DHCP is selected as an IP address setting, the
number of characters is limited to 13 characters.

¢ In the [Comment] box, type a comment about the printer using less than
31 characters.

NetBEUI

@ Click the [General] tab, and then type a comment into the [Comment] box.

In the [Comment] box, type a comment about the printer using less than 31
characters.

@ Click the [NetBEUI] tab.
© Type the computer name into the [Computer Name] box.

* In the [Computer Name] box, type a name that helps you to identify a
printer using the NetBEUI protocol. The factory default name consists
of "RNP" and the last 3 bytes of the MAC address on the Network Inter-
face Board. For example, when the MAC address is 00:00:74:62:7D:D5,
the factory default name is "RNP627DD5". A maximum of 13 characters
consisting of uppercase English letters, numbers, or symbols (except
"*+,/5<=>?[\]l. and space) can be used. No name is permitted if the
prefix is "RNP". You must avoid using a name already used.

* In the [Comment] box, type a comment about the printer using less than
31 characters.

A ciick [0k
The NIB Setup Tool closes, and the settings are transmitted to the printer.

ﬂ Exit SmartNetMonitor for Admin.
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Web Browser

ﬂ Run the Web browser.

g Type the address "http:// (IP address of the printer for which you want to
change the settings)".

The status of the selected printer is displayed on the Web browser.

B Click [Configuration].

A dialog box that prompts you to type the user name and a password ap-
pears.

ﬂ Type the user name and the password, and then click [OK].

Type only the password in this dialog box. The factory default password is
"password".

B Change names and comments.

TCP/IP

@ Click [General], and then type the name into the [Device Name:] box and a
comment into the [Comment] box.

¢ In the [Device Name:] box, enter the name of the printer using less than 13
characters. The factory default name consists of "RNP" and the last 3
bytes of the MAC address on the Network Interface Board. For example,
when the MAC address is 00:00:74:62:7D:D5, the factory default name is
"RNP627DD5". No name of 9 characters is permitted if the prefix is
"RNP". Also, when DHCP is selected as an IP address setting, the
number of characters is limited to 13 characters.

* In the [Comment] box, type a comment about printer using less than 31
characters.

NetBEUI

@ Click [NetBEUI].

@ Type the name into the [Computer Name] box and a comment into the [Com-
ment] box.

* In the [Computer Name] box, type a name that helps you to identify print-
ers using the NetBEUI protocol. The factory default name consists of
"RNP" and the last 3 bytes of the MAC address on the Network Interface
Board. For example, when the MAC address is 00:00:74:62:7D:D5, the
factory default name is "RNP627DD5". A maximum of 13 characters
consisting of uppercase English letters, numbers, or symbols (except
"*+,/5<=>?[\]Il. and space) can be used. No name is permitted if the
prefix is "RNP". You must avoid using a name already used.

* In the [Comment] box, type a comment about the printer using less than
31 characters.
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A click [appiy].
The settings are transmitted to the printer.

ﬂ Exit the Web browser.

Displaying the Status of Printers

You can view the status of printers using SmartNetMonitor for Admin, Smart-
NetMonitor for Client, or Web browser.

SmartNetMonitor for Admin

ﬂ Run SmartNetMonitor for Admin.

g Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or
[IPX/SPX].
The status of printers is indicated with an icon in the list.

& Note

O For more information about the status icons, see SmartNetMonitor for Ad-
min Help.

B For more information, click to select the desired printer from the list, and
then click [Open] on the [Device] menu.

The status of the printer is displayed in the dialog box.

& Note
O For more information about each item in the dialog box, see Help.

SmartNetMonitor for Client

To view the status of a printer using SmartNetMonitor for Client, you must, in
advance, configure SmartNetMonitor for Client so it monitors the printer whose
status you want to view.

Monitoring Printers

ﬂ Run SmartNetMonitor for Client.
The “Welcome to SmartNetMoniter for Client” screen appears.

@ Note

O Click on [Do not show this message again.] to stop the message being dis-
played each time you launch SmartNetMoniter for Client.

O The remaining instructions in this manual assume that this screen is not

displayed.
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B cick [0k,
The SmartNetMonitor for Client icon appears at the right end of the taskbar.
B Right-click the SmartNetMonitor for Client icon, and check if the desired
printer is configured on the pop-up menu that appears.
If it is configured, see SmartNetMonitor for Client Help.

ﬂ If the desired printer is not configured, click [Options] on the pop-up menu.
The [SmartNetMonitor for Client - Options] dialog box appears.

B Click the printer to be monitored, and select the [To Be Monitored] check box
from the [Monitoring Information Settings] group.

& Note

O Selecting the [Displayed on Task Bar] check box will show the status of a
printer with an icon on the SmartNetMonitor for Client icon on the task
bar.

A ciick [0k
The dialog box closes and the configured printer is monitored.

Displaying the Status of Printers

ﬂ Run SmartNetMonitor for Client.

g The status of printers is displayed on the SmartNetMonitor for Client icon
on the task bar.

& Note

O For more information about the status icons, see SmartNetMonitor for Cli-
ent Help.

B For more information on the status, right-click the SmartNetMonitor for
Client icon, and then click the desired printer.
The status of the printer is displayed in the dialog box.

& Note
O For more information about each item in the dialog box, see Help.
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Web Browser

ﬂ Run the Web browser.

g Type the address "http:// (IP address of the printer whose status you want
to view)".

The status of the selected printer is displayed in the Web browser.
B Click [Status] and you can check the status of the printer.

& Note
O For more information about each item, see Help.
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Assigning IP Address with ARP+PING

Using TCP/IP, you can assign the IP address using ARP and PING. The follow-
ing example is for a BSD UNIX workstation (SunOS 4.x).

5] Preparation

ARP+PING should be set to active on the network boot configuration before
assigning the IP address using ARP+PING. For more information about set-
ting it to active, see Printer Reference 1.

ﬂ Log on to the workstation as root.

g Use the arp command to assign the IP address to the MAC address of the
Network Interface Board.

# arp -s 192.168.15.16 00:00:74:62:5C:65

& Note
O 192.168.15.16 is the IP address, 00:00:74:62:5C:65 is the MAC address.

B Assign the IP address using the ping command.
# ping 192.168.15.16

ﬂ Use the ping command again to confirm the address.
# ping 192.168.15.16
If the address has been configured correctly, the following message appears.
192.168.15.16 is alive

If the address has been configured incorrectly, the following message ap-
pears.

no answer from 192.168.15.16

$How to Confirm the MAC Address

The MAC address (Ethernet address) of the Network Interface Board is required
in order to use ARP and PING to assign the IP address.

The MAC address can be seen on the system configuration list.

A Reference
For how to print the system configuration list, see Printer Reference 2.

& Note

O The MAC address can also be seen on the system configuration list. For more
information about the system configuration list, see p.123 “System Configu-
ration List (Network Configuration)”.
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Remote Maintenance by telnet (mshell)

You can view the machine status and configure the Network Interface Board us-
ing telnet.

& Note

O You should specify a password so that only the network administrator, or a
person having network administrator privileges, can use remote mainte-
nance.

Using telnet

The following is a sample procedure in using telnet.

? Limitation

O Only one person at a time can be logged on to do remote maintenance.

ﬂ Using the IP address or host name of the machine, start telnet.

% telnet IP address

& Note
O In order to use the host name instead of the IP address, you must write it

to the /etc/hosts file.

g Type the password.

& Note
O The factory default is “password”.

B Type a command.

/O Reference
For more information about telnet commands, see p.96 “Commands List”.

ﬂ Exit telnet.
msh> logout

When the configuration is changed, a confirmation message requests whether
or not the changes should be saved.

B Type “yes” to save the changes, and press the [ENTER] key.

If you do not want to save the changes, type “no”and press the [ENTER] key.
If you want to make additional changes, type “return” at the command line,
and press the [ENTER] key.

@ Note

O If the “Cannot write NVRAM information” message appears, the changes
are not saved. Repeat the steps above.
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O The Network Interface Board is reset automatically when the settings are
changed.

O When the Network Interface Board is reset, the active print job which has
already been sent to the machine will finish printing. However, jobs that
have not been sent yet will be canceled.

Commands List

This is a list of commands that can be used via remote maintenance.

& Note
O Type “help” to see a list of commands that can be used.

msh> help

O Type “help command_name” to display information about the syntax of that
command.

msh> help command name

TCP/IP address

Use the ifconfig command to configure TCP/IP for the machine (IP address, sub-
net mask, broadcast address, default gateway address).

«» Reference
msh> ifconfig

< Configuration
msh> ifconfig le0 parameter address

Parameter Meaning

(no parameter) IP address

netmask subnet mask

gateway default gateway address

The following is an example for configuring an IP address of 192.168.15.16.
msh> ifconfig le0 192.168.15.16

The following is an example for configuring a subnet mask of 255.255.255.0.
msh> ifconfig le0 netmask 255.255.255.0

@ Note

O This affects the configuration of the Network Interface Board of the IP ad-
dress that is used.

O To type an address using hexadecimal, prefix it by “0x”.
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’iQ'FAddress

% Subnet Mask
A number used to mathematically “mask” or hide the IP address on the net-
work by eliminating those parts of the address that are alike for all the ma-
chines on the network.

< Default Gateway Address
A gateway is a connection or interchange point that connects two networks.
A gateway address is for the router or host computer used as a gateway.

& Note
O To get the above addresses, contact your network administrator.

Access Control

Use the access command to view and configure access control.
You can also configure multiple access controls with the multi command.

< Reference
msh> access

< Configuration
msh> access parameter address

Parameter Meaning

control Access Control Address

mask Access Control Mask
& Note

O The Access Control Address and the Access Control Mask are used to limit
access to the computer used for printing by denying access to users based on

their IP address. If it is not necessary to limit access, set the Access Control
Mask to “0.0.0.0”.

O When the Access Control Address matches the masked result of the IP ad-
dress computer attempting to print, print jobs from that IP address will be ac-
cepted by the Network Interface Board.
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O For example, if you assign 192.168.15.16 as the Access Control Address of the
Network Interface Board, the IP addresses that can print are as follows. XXX

means any number from 1 to 255 is acceptable.

Access Control Mask

IP addresses that can access the
machine

0. 0. O.

XXX . XXX . XXX . XXX

255. 0. 0.

192 . XXX .XXX.XXX

255.255. 0.

192.168.XXX.XXX

255.255.255.

0
0
0
0

192.168. 15.XXX

255.255.255.255

192.168. 15. 16

« Configuration for multiple access controls
msh> access multi {on | off}
*“on” means active and “off” means inactive.
msh> access {1 - 5} parameter address

@ Note

O Up to 5 access controls are available. Specify the number (1 - 5) when con-
figuring some access controls. If this is not configured, the first setting is

selected.

Network Boot

Use the set command to configure the boot method.

msh> set parameter {on | off}

*“on” means active and “off” means inactive.

Parameter Meaning
ping ARP+PING
tftp RARP+TFTP
bootp BOOTP
dhcp DHCP (Dynamic Host Configuration
Protocol)
& Note

O When you use RARP+TFIP, BOOTP or DHCP, the server also needs to be

configured.

O DHCP takes precedence over all other settings.
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Protocol

Use the set command to allow/prevent remote access for each protocol.

msh> set protocol {up | down}

Protocol

appletalk

tepip
netware

“up” means active and “down” means
inactive.

netbeui
lpr

ftp

rsh
diprint
npmp
web

snmp

ipp

& Note

O If you prohibit remote access using TCP/IP and then log out, you cannot use
remote access. If this was a mistake, you can use the machine's operation pan-
el to allow access by TCP/IP.

O When you prevent access via TCP/IP, you are also prevented from using lpr,
ftp, rsh, diprint, web, snmp, npmp, and ipp.

Machine status

The following commands can be used to get information about the current status
of the machine.

msh> command

Command Information that is displayed
info Information about the paper tray, output tray
and printer language of the machine.
netstat Information about the Network Interface
Board. (Network Statistical Information)
& Note

O More information about any print job is displayed when the ID number is
added after the prnlog command.

p Reference

For more information about the meaning of the data returned with these com-
mands, see p.108 “Configuring the Network Interface Board”.
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Network Interface Board configuration settings information

Use the show command to display the Network Interface Board configuration
settings.

msh> show [-pl]

@ Note

O Add “-p” to the show command to have the information displayed one screen
at a time.

A Reference
For more information about the meaning of the data returned with this com-
mand, see p.108 “Configuring the Network Interface Board”.

System log information

Use the syslog command to display information stored in the machine's system log.
msh> syslog
A Reference

For more information about the displayed information, see p.111 “System
Log Information”.

SNMP

Use the snmp command to display and edit SNMP configuration settings such
as the community name.

& Note
O You can configure from ten SNMP access settings numbered 1-10.

O Default access settings 1 and 2 are as follows.

Number 1 2
Community name public admin
IP address 0.0.0.0 0.0.0.0
Access type read-only read-write
trap off trap off
< Display

Shows the SNMP information and available protocols.
msh> snmp ?
msh> snmp [-p] [registered number]

& Note
O If the -p option is added, you can view the settings one by one.

O Omitting the number displays all access settings.
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< Community name configuration
You can set the community name of the Network Interface Board.

msh> snmp number name community name

@ Note
O The community name must consist of 15 characters or less.

¢

< Access type configuration
You can select the access type from those listed below.
msh> snmp number type access type

Access type Type of access which is permitted
read Read only

write Read and write

trap User is notified of trap messages.
no All access is denied.

< Protocol configuration
You should use the following command to set the protocols to active or inac-

tive. If you set a protocol to inactive, all access settings set to use that protocol
are disabled.

msh> snmp {ip | ipx} {on | off}

e “on” means active and “off” means inactive

To change the protocol of an access settings, use the following command.
However, if you disabled a protocol with the above command, making it ac-
tive here will have no effect.

msh> snmp number active {ip | ipx} {on | off}

< Access configuration
You can configure the address of a host depending on the protocols used.
The Network Interface Board accepts requests only from hosts having ad-
dresses with access types of “read-only” or “read-write”. Type “0” to have the
Network Interface Board accept requests from any host without requiring a
specific type of access.

Command syntax:
msh> snmp number {ip | ipx} address

& Note

O To specify the TCP/IP protocol, type ip followed by a space and then the
IP address.

O To specify the IPX/SPX protocol, type ipx followed by a space and then the
IPX address followed by a decimal and then the MAC address of the Net-
work Interface Board.
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The following is an example of how to configure registration number 3 with
the IP address 192.168.15.16.

msh> snmp 3 ip 192.168.15.16

The following is an example of how to configure registration number 3 with
the IPX address 7390A 448, and the MAC address 00:00:74:62:5C:65.

msh> snmp 3 ipx 7390A448.000074625C65

IPP

Use the ipp command to configure the IPP settings.

2
**

<

L)

9
%

View settings
The following command displays the current IPP settings.

msh >ipp
Example output:

timeout=900 (sec)
auth basic

e The "timeout" setting specifies how many seconds the computer keeps try-
ing to access the network printer to send print jobs when no connection
could be made.

* The "auth" setting indicates the user authorization mode.

IPP timeout configuration
Specify how many seconds to wait before canceling a print job if it has been

interrupted for some reason. The range of time can be changed between 30 to
65535 seconds.

msh>ipp timeout {30 -65535}

IPP user authorization configuration

Use the IPP user authorization to restrict users that can print with IPP. The
factory default is “off”.

ipp auth {basic|digest|off}
* "basic" and "digest" are user authorization setting.
e “off” removes a user's authorization.

& Note

O If you select "basic" or "digest", see next section”Configuring the IPP user
authorization” for how to configure the user name. Up to ten user names
are available.
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« Configuring IPP user authorization
Use the following command:

ipp user
The following message appears.

Input user number (1 to 10):
Type the number, user name and password.

IPP user name:userl
IPP password:****k*%*
After configuring the settings, the following message appears.

User configuration changed.

Changing the password

Use the passwd command to change the remote maintenance password.

ﬂlmportant
O Be sure not to forget or lose the password.

& Note
O The default factory password is “password”.

ﬂ Type “passwd”.

msh> passwd

g Type the current password.
01ld password:

B Type the new password.

New password:

& Note

O The password must consist of 3 to 8 alphanumeric characters and symbols.
Upper and lower case characters are considered unique. For example, R is
different from r.

O The password is the same as that used in the configuration of the Network
Interface Board using a Web Browser and that used in the NIB Setup Tool.
If you change a password from telnet, the other passwords are also
changed.
ﬂ Type the new password once again.

Retype new password:
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Changing the NetBIOS name

Use the hostname command to change the NetBIOS name of the machine.

msh> hostname NetBIOS name of the machine
& Note

O The NetBIOS name consists of up to 13 alphanumeric characters.
O You cannot use a name starting with “RNP” or “rnp”.

WINS

Use the wins command to configure the WINS server.

A Reference
For how to configure the WINS server, see p.120 “Configuring a WINS Serv-

7

er .
< WINS configuration

Use the set command to make WINS active or inactive.
msh> set wins {on|off}

e “on” means active and “off” means inactive.

< View settings
The following command displays the IP addresses of the WINS server.
msh> wins
Example output:
wins: primary server 192.168.10.1 secondary server
192.168.10.2
wins server current config: primary server 192.168.10.1
secondary server 192.168.10.2 hostname 123456789abcd Sco-
peID

& Note

O The current configuration appears on the second line when DHCP is ac-
tive. When DHCP is not active, there is no second line.

O If the network boot setting is changed to another from DHCP, the WINS
server IP addresses that were saved on the machine may differ from the
current IP addresses.

< Address configuration
Specify the WINS server IP addresses.
msh> wins {primary|secondary} IP address
Use “primary” to specify the primary WINS server IP address, and use “sec-
ondary” to specify the secondary WINS server IP address.



Remote Maintenance by telnet (mshell)

AutoNet

Use the set command to configure AutoNet.

/O Reference
For more information about AutoNet, see p.122 “Using AutoNet”.

msh> set autonet {on|off}

*“on” means active and “off” means inactive.

Changing the password

Use the passwd command to change the remote maintenance password.

ﬂlmportant
O Be sure not to forget or lose the password.

& Note
O The default factory password is “password”.

ﬂ Type “passwd”.

msh> passwd

g Type the current password.

0ld password:

B Type the new password.

New password:

@ Note

O The password must consist of 3 to 8 alphanumeric characters and symbols.
Upper and lower case characters are considered unique. For example, R is
different from r.

O The password is the same as that used in the configuration of the Network
Interface Board using a Web Browser and that used in the NIB Setup Tool.
If you change a password from telnet, the other passwords are also
changed.

ﬂ Type the new password once again.

Retype new password:
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SNMP

The Network Interface Board functions as a SNMP (Simple Network Manage-
ment Protocol) agent using the UDP and IPX protocols. Using the SNMP man-
ager you can get information about the machine.

The factory default community names are “public” and “admin”. You can get
MIB information using these community names.

/O Reference

For more information about configuring the community name, see p.100
“SNMP” in “Remote Maintenance by telnet”.

? Limitation

O The kinds of supported MIBs differ depending on the printer.

< Supported MIBs
e MIB-II
® PrinterMIB
e HostResourceMIB
¢ RicohPrivateMIB
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Understanding the Displayed Information

This section describes how to read status information returned by the Network

Interface Board.

Network Statistical Information

Use the following command to view Network Interface Board network statistics.

Detailed information about the words used to describe the status of the Network
Interface Board are described below.

¢ mshell : Use the info command. = p.99 “Machine status”

Item name

Meaning

System elapsed time

The time that has passed since the Network Interface Board start-
ed.

Total printing time

The total time spent in processing the print data.

Total open count

The total open (printing process) count that the application re-
quired.

Current connection count

The current number of open connections with the Network Inter-
face Board.

Total connection count

The total number of print jobs sent to the Network Interface
Board.

Print error count

The number of times the printing process sent an error message.

Access error count

The number of times the connection was refused because of the
access control value.

Print request full count

The number of times a connection was refused because the
number of print requests exceeded the number of allowed ses-

sions.
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Configuring the Network Interface Board

The Network Interface Board settings can be displayed and confirmed using the
commands below.

e mshell : Use the show command. = p.100 “Network Interface Board config-
uration settings information”

Item name Meaning

Common
Mode
Protocol Up/Down Up means active, Down means inactive.

AppleTalk
TCP/IP
NetWare
NetBEUI
NVRAM version Internal version number.

Device name

Comment
Location
Contact
Soft switch
AppleTalk
Mode AppleTalk protocol in selection.
Net Network number.
Object Macintosh printer name.
Type The type of printer.
Zone Name of the zone that the machine belongs to.




Understanding the Displayed Information

Item name Meaning
TCP/1P
Mode Up means active, Down means inactive.
ftp
lpr
rsh
diprint
web
telnet
download
npmp
snmp
ipp
wins
EncapType Frame type.
Network boot Network boot.
Filter Internal parameter.
Max DSTs Internal Information
Address IP address.
Netmask Subnet mask.
Broadcast Broadcast address.
Gateway Default gateway address.
AccessCtrl Access control address.
AccessMask Access control mask.
Primary WINS Primary WINS server address
Secondary WINS Secondary WINS server address
Time server
Home page URL URL of homepage.
Home page link name URL name of homepage.
Help page URL URL of help page.
SNMP protocol Protocol used with SNMP.
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Print server name
Fileservername
Context name
Switch
Mode
NDS/Bindery

Print job timeout

Packet negotiation

Item name Meaning

NetWare
Mode (this value is fixed)
EncapType Frame type.
RPRINTER number Remote printer number.
RPRINTER name Remote printer name.

Print server name.
Name of the connect file server.

Context of print server.

Active mode.

(this value is fixed)

Time of the job timeout.

NetBEUI
Mode
Switch
Mode
diprint
Notification
Workgroup name
Computer name
Comment

Share name[1]

(this value is fixed)

(this value is fixed)

(this value is fixed)

Notification of print job completion.
Name of the workgroup.

Name of the computer.

Comment.

Share name (name of the printer type).

Shell mode

Mode of the remote maintenance tool.




Message List

Message List

This is a list of messages written to the machine's system log. The system log can

be viewed using the syslog command.

System Log Information

You can use the following methods to view the system log.

¢ mshell : Use the syslog command. = p.100 “System log information”

Message when the Network Interface Board starts or restarts

Network Interface Board Ver.x.x.x

The version number of the Network Interface
Board.

PRINTER SYSTEM “system name” Ver.x.x.x

The system name and version of the machine.

Attach FileServer="file server name”

7

The machine is attached to “file server name”
as the nearest server.

Current Interface Speed:xxxMbps

The speed of the network (10 Mbps or 100 Mb-
ps).

Current IPX address

The current IPX address.

Frametype="frame type name”

The "frame type name" is configured to be
used on NetWare.

7

NetBEUI Computer Name="computer name’

The NetBEUI Computer Name is defined as
"computer name".

Start httpd The Web server has been started.
Start npmpd for IPX The npmpd for IPX protocol has been started.
Start npmpd for TCP/IP The npmpd for TCP/IP protocol has been

started.

Start smbd direct print mode(NetBEUI)

You can print from a client on the Windows
network via the print server.

Start snmpd Ver.2.0

The SNMP agent of the displayed version has
been started.

Vendor=, Country=, Lang=

The vendor, the country code, and the lan-

guage.
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NetWare (When the Network Interface Board is started)

< When working as a print server

Access to NetWare server “file server name”
denied. Either there is no account for this
print server on the NetWare server or the
password was incorrect.

Cannot log in to the file server. Confirm that
the print server is registered on the file serv-
er. If a password is specified for the print
server, delete it.

Attach to print queue “print queue name”

Attached to the print queue.

Login to fileserver “file server name”
(“NDS | BINDERY”)

Logged in to the file server with NDS or
BINDERY mode.

Open log file “file name”

The specified log file has been opened.

Printer “printer name” has no queue

The print queue is not assigned to the ma-
chine. Using NWAdmin, assign the print
queue to the machine, and then restart it.

Print queue “print queue name” cannot be
serviced by printer 0, “print server name”

Print services are not available for the print
queue. Confirm that the volume of the print
queue exists on the specified file server.

The print server received error “error
number” during attempt to log in to the net-
work. Access to the network was denied.
Verify that the print server name and pass-

Cannot log in to the file server. The print
server is not registered or the password is
specified. Register the print server without
specifying a password.

word are correct.

< When working as a remote printer

Cannot create service connection

Cannot establish a connection with the file
server. Your request may exceed the maxi-
mum number of connections that the file
server can deal with at a time.

Cannot find the printer (“print server
name” /”printer number”)

The printer having the number displayed on
the print server does not exist. Confirm the
number of the machine registered to the
print server.

Establish a connection with the print server,
“print server name”

A connection with the print server has been
established.

No local target for “print server name”

Cannot get routing information about the file
server. If a different frame type is configured
from that used on the network, you should
select "Auto Select" as a frame type.

Required file server (“file server name”) not
found

Cannot find the required file server.

Could not to attach to print server (“print
server name”

Cannot connect to the print server. The print
server refuses a connection for some reason.
Confirm the configuration of the print serv-
er.
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NetBEUI (When the Network Interface Board is started)

Back to default name (<Computer name>) The same computer name is detected on the

network. As unable to add computer name to
the suffix, the computer name back to default
name. Configure a new computer name that is

unique.
Print session full Cannot accept the print session.
Required computer name (<Computer The same computer name is detected on the
name>) is duplicated name network. The start job determines the compu-

ter name by adding the computer name to the
suffix (0,1....). Configure a new computer
name that is unique.

TCP/IP

< When the address is configured

Invalid gateway address The gateway address is not correct for the
specified IP address.

< When using Ipr

filter data error Some data cannot be handled by the filter
option. Confirm the file code and the settings
of the filter option.

lost connection The connection was cut by the other party.
Check the machine to which you requested
to print.

print requests full Cannot accept the print request (max. 5 ses-

sions). Confirm the status of the machine
with Ipg, rsh, rcp or ftp, and print it again af-
ter the print request becomes less than 5 ses-
sions.

However, the maximum request when using
ftp command is 3.

printer permission denied Cannot get permission to use the machine.
Confirm the access rights with the access
control address and the access control mask.

printer refuse Something is wrong with the machine. Con-
firm the status of the machine.

At the beginning of the message, the IP address of the client is displayed with-
in parentheses.
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< When using rsh, rcp, ftp

4

Can't build data connection: “message’

Cannot establish a connection for data trans-
fer due to the displayed error. Check the ftp
of the workstation that requested the print
job, and start it again. When using ftp, this
message remains only on the system log in-
formation.

cmd_name:Command not supported

The remote shell command using cmd_name
is not supported. You should use only the
print, stat, syslog and info, commands. You
should access the machine only with rsh and
rcp remote shell commands.

command line too long

The command line is too long.

file_name:No such file or directory

You must use a file name with the stat, sys-
log, info and install commands.

filter data error

Some of the data cannot be handled with the
filter option. Confirm the file code and the
settings of the filter option.

get log busy

Another machine is getting the log informa-
tion. You should get it afterwards.

lost connection

The connection was cut by the other party.
Check the ftp of the workstation that re-
quested the print job, and start it again.
When using ftp, this message remains only
on the system log information.

no more ftp execute

More than three users at a time cannot log in
using ftp. Since there are three other users
that have already logged in, wait until the
job is finished.

print requests full

Cannot accept the print request.(max. five
sessions) Confirm the status of the machine
with Ipq, rsh, rcp, and ftp commands, and
print it again after the number of print re-
quests (sessions) becomes less than five.

However, the maximum request when using
ftp command is 3.

printer busy

Cannot get the machine information. Anoth-
er user may be accessing it. Wait a few min-
utes before trying again.

printer permission denied

Cannot get a permission to use the machine.
Confirm the access right with the access con-
trol address and the access control mask.

printer refuse

Something is wrong with the machine. Con-
firm the status of the machine.

At the beginning of the message, the IP address is displayed in parentheses.
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< When using SNMP

Exit snmpd

The agent is complete. Reset the machine or
turn the machine off and on.

recvfrom:packet discarded,length(Reception
packet length)> (Packet size),from addr <Ad-
dress of partner point>

The received packet was ignored since the
length of the packet exceeds the limit. Con-
firm whether the administration station sent
a packet is longer than 1025 bytes.

session <Community name appointed> not
defined

The community name of the received packet
is not defined. Confirm that the community
name of the administration station is the
same as that specified for the machine.

snmpin:Bad use of session <community
Name> from <Address>

The community name of the received packet
is not the same as that of the administration
station. Confirm the community name spec-
ified to the machine.

snmpin:error in snmpdecipher,code (<Error
number>)

An error occurred with the received packet.
Check if the number of the objects sent from
the administration station is more than 31
and if there are wrong MIB requests.

snmpin:error in snmpservsend,code (<Error
number>)

Cannot send a response packet. Normally,
this message is followed by the messages be-
low *1 *2.

snmpin:pkt too large,code (<Error
number>)"!

The response packet to the request is too big
to send. Reduce the number of the objects
per request.

snmpin:error in sending too large request
back,code (<Error number>),giving up™

The packet notifying the error is too big to
send. Reduce the number of the objects per
request.

snmpin:received bad version

The version of the received packet is invalid.
Confirm that the version of the administra-
tion station is version-1(0).

Error numbers in the messages are codes for internal use.

< When using DHCP

Connected DHCP Server(<IP address as-
signed by the DHCP server>)

The IP address is assigned by the DHCP
server.

Current IP address(<Current IP address>)

This IP address assigned by the DHCP serv-
er is used.

DHCEP lease time is infinity

Lease time of the IP address assigned by the
DHCEP server is infinity.

Auto-configured IP address(<Current IP ad-
dress>)

This IP address assigned by AutoNet is
used.

115



116

Appendix

< When using WINS

WINS Server=<IP address of the WINS serv-
er> NetBIOS Name=<NetBIOS name>

Registering the NetBIOS name of the ma-
chine with the WINS server is complete.

WINS server address 0.0.0.0

The WINS server IP addresses are not speci-
fied. Specify the IP addresses.

WINS name registration/refresh error code
(Error number)

Cannot register or refresh the NetBIOS
name of the machine with a WINS server.

Check if the WINS server IP addresses are
specified correctly.

Confirm that WINS server is available.

Configure a new NetBIOS name that is
unique.

WINS name registration: Server No Re-
sponse

WINS name refresh: Server No Response

There is no reply on registration or refresh
request from the WINS server.

Check if the WINS server IP addresses are
specified correctly.

Confirm that WINS server is available.

WINS wrong scopelD

The wrong scope ID is used.

Configure the correct scope ID.

The Error number is the number that is sent in response to the WINS server

error code.




Precautions

Precautions

Please pay attention to the following when using the Network Interface Board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial Up Router to a Network

When the NetWare file server and the machine are on the opposite side of a rout-
er, packets are continuously sent back and forth, possibly causing communica-
tion charges to increase. Because the packet transmission is a specification of
NetWare, you need to change the configuration of the router. If the network you
are using does not allow you to configure the router, configure the machine.

Configuring the router

Filter the packets so that they do not pass over the dial up router.

& Note

O The MAC address of the machine doing the filtering is printed on the system
configuration list. For more information about printing the system configura-
tion list, see p.123 “System Configuration List (Network Configuration)”.

O For more information about configuring the machine if the router cannot be
configured, see the instructions below.

Configuring the machine with NetWare

ﬂ Following the setup method in this manual, configure the file server.
g Set the frame type for a NetWare environment.

A Reference
For more information about selecting a frame type, see Printer Reference 1.

Configuring the machine without NetWare

ﬂ While not printing, the Network Interface Board sends packets on the net-
work. Set the NetWare to inactive.

A Reference
For more information about selecting a protocol, see Printer Reference 1.
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PostScript Printing from Windows

When printing PostScript from Windows, see Printer Reference 2 for how to con-
figure the Network Interface Board and printer driver.

NetWare Printing

Form Feed

You should not configure the form feed on NetWare. The form feed is controlled
by the printer driver on Windows. If the NetWare form feed is configured, the
machine might not print properly. If you want to change the form feed setting,
always configure it on Windows.

e With Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-
tings] tab in the Printer Properties dialog box.

e With Windows 2000, clear the [Form feed] check box on the [Netware Settings]
tab in the Printer Properties dialog box.

e With Windows NT 4.0, clear the [Form feed] check box on the [Netware Settings]
tab in the Printer Properties dialog box.

Banner Page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it on Windows.

e With Windows 95/98/Me, clear the [Enable banner] check box on the [Printer
Settings] tab in the Printer Properties dialog box.

e With Windows 2000, clear the [Enable banner] check box on the [Netware Set-
tings] tab in the Printer Properties dialog box.

e With Windows NT 4.0, clear the [Enable banner] check box on the [Netware Set-
tings] tab in the Printer Properties dialog box.

Printing after resetting the machine

After resetting the remote printer, it will be cut off from the print server for about
30-40 seconds before connecting again. Due to the NetWare specification, print
jobs may be accepted, but they will not be printed during this interval.

When using the machine as a remote printer, wait about 2 minutes after resetting
the machine before attempting to print.
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When Using DHCP

Note the following points when using DHCP (Dynamic Host Configuration Pro-
tocol).

Supported systems

Windows 2000 Server, Windows NT Server 4.0 and NetWare 5 can be config-
ured as a DHCP server.

Configure the machine with a reserved IP address

To always assign the same IP address, configure a reserved IP address using the
DHCP server.

@ Note

O When multiple DHCP servers are used, reserve the same address with each
DHCP server. The Network Interface Board needs to receive information
from the DHCP server that it contacts.

Follow these steps to configure the machine with a reserved IP address.
ﬂ Start the DHCP manager.

g Select the scope that will be used, and on the [Scope] menu, click [Reserva-
tion].

B Type the IP address into [IP Address].

ﬂ Type the MAC address of the Network Interface Board into [Unique Identifi-
er].

& Note

O Do not use hyphens to separate the numbers.

O If you do not know the MAC address, it can be found on the system con-
figuration list. = p.123 “System Configuration List (Network Configura-
tion)”

B Type aname and comment into the [Client Name] box and the [Client Comment]
box.

& Note

O For more information about client names, see p.120 “Additional informa-
tion”.

A click [Adq).

An IP address is reserved.

ﬂ Click [Close] to close the dialog box.
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Additional information

e When you click [Active Lease] on the [Scope] menu of DHCP manager, a list of
client leases appears. When the reserved IP address is not active, the name of
the reservation is the name entered in the Client Name field of the Add Re-
served Clients dialog box. When the reserved IP address becomes active, the
client name changes to the printer name configured by the Network Interface
Board. Only the first 13 letters of the printer name appear here. When you use
the machine with SmartNetMonitor for Admin, use the host name of the ma-
chine as the [Client Properties] Client Properties dialog box.

¢ When the DHCP server does not assign an IP address, the Network Interface
Board uses 11.22.33.44 as a temporary IP address. You can confirm the ma-
chine's IP address on the system configuration list.

* Because 11.22.33.44 is a special IP address, you cannot print using this ad-
dress.

¢ When using the DHCP relay agent in a network environment that uses a dial
up router to connect to the Network Interface Board, an increase in commu-
nication fees can occur.

Configuring a WINS Server

The machine can be configured to register its NetBIOS name with a WINS server
when power is turned on. This enables the NetBIOS name of the machine to be
specified from SmartNetMonitor for Admin even in a DHCP environment.

This section describes how to configure the WINS server.

& Note
O WINS Server is supported with Windows NT 4.0 Server Service Pack 4 or lat-
er, and Windows 2000 Servers WINS Manager.

O For more information about settings of WINS Server, see Windows Help.

O If there is no reply from the WINS Server, the NetBIOS name will be regis-
tered by broadcast.

O The NetBIOS name consists of up to 13 alphanumeric characters.

Using a WWW browser

ﬂ Start the Web browser.

gPoint your browser at the URL or IP address of the machine (e.g.
“http://XXX.XXX.XXX"” substituting the Xs with the IP address).

The status of the machine you chose appears on the Web browser.

B Click [Network Config.].
The dialog box for entering the password and user name is displayed.
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ﬂ Enter your user name and password, and then click [OK].

To use the factory default account, enter no user name and type "password"
for the password.

B clic [repar.

E Set [WINS] to active and enter the IP address of the WINS server in [Primary
WINS Server] and [Secondary WINS Server].

t click [Refresh).
B Exit the Web browser.

g Restart the machine.

Using telnet

ﬂ Connect to the remote printer using telnet.

ﬂ Use the set command to make WINS active.

msh> set wins on

B Specify the IP addresses (primary and secondary) using the following commands.
msh> wins primary IPaddress

msh> wins secondary IPaddress

& Note
O To confirm the current configuration, use the show command.

ﬂ Log off from telnet.

B Restart the machine.

Using DHCP

You can use the machine under a DHCP environment. You can also register the
printer NetBIOS name on a WINS server when it is running.

& Note

O Printers that register their NetBIOS name on a WINS server must be config-
ured for the WINS server.

O Supported DHCP servers are Windows NT 4.0 Server Service Pack 4 or later,
Windows 2000 Server and NetWare 5.

O If you do not use WINS server, reserve machine's IP address in DHCP server
so that the same IP address is assigned every time.

O DHCP relay-agent is not supported. If you use DHCP relay-agent on a network via
an ISDN line, it will result in expensive line charges. This is because your computer
connects to the ISDN line whenever a packet is transferred from the machine.
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Using AutoNet

If the machine's IP address is not assigned by a DHCP server automatically, a
temporary IP address starting with 169.254 which is not used on the network can
be selected automatically by the machine.

& Note

O The IP address assigned by the DHCP server is given priority to that selected
by AutoNet.

O You can confirm the current IP address on the system configuration list.

O When AutoNet is running, the NetBIOS name is not registered on the WINS
server.

When Using the NIB Setup Tool

If the Network Interface Board cannot browse using the TCP/IP protocol, con-
firm that the TCP/IP environment is correctly configured in your computer.

When Using IPP with SmartNetMonitor for Client

When using IPP with SmartNetMonitor for Client, note the following;:

¢ The network printer can only receive one print job from SmartNetMonitor for
Client at a time. While the network printer is printing a job, another user can-
not access the network printer until it completes the job. In this case, Smart-
NetMonitor for Client tries to access the network printer until the retry
interval expires.

¢ If SmartNetMonitor for Client cannot access the network printer and times
out, SmartNetMonitor for Client stops sending the print job. In this case, you
should cancel the paused status from the print queue window. SmartNet-
Monitor for Client will resume access to the network printer. You can delete
the print job from the print queue window, but canceling a print job that has
been printed by the network printer might cause the next print job sent from
another user to be incorrectly printed.

* If a print job that is sent from SmartNetMonitor for Client is interrupted and
the network printer cancels the job because something went wrong, launch
the print job again.

* Print jobs sent from another computer do not appear in the print queue win-
dow regardless of the protocol.

e If various users send print jobs using SmartNetMonitor for Client to network
printers, the printing order might not be in the order in which the jobs were
sent.

e AnIP address cannot be used for the IPP port name because the IP address is
used for the SmartNetMonitor for Client port name.
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System Configuration List (Network Configuration)

You can confirm the network information on the system configuration list.

n Confirm that the machine is online.

ﬂ Print the system configuration list.

/O Reference

For more information about printing the system configuration list, see

Printer Reference 2.
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